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1 ACPS Overview

Overview

The File Menu

The Edit Menu

The Calculation Menu

The Utilities Menu

The Help Menu

References

About ACPS

Help File Updated: Saturday, October 13, 2018

1.1 Overview

Pillar design is one of the fundamental elements of mining engineering. Pillars are
necessary to control the great weight of the overburden during all phases of underground
mining. Without stable pillars, ground control is impossible.

Thirty years ago, the Analysis of Longwall Pillar Stability (ALPS) inaugurated a new era
in coal pillar design. ALPS was the first empirical pillar design technique to consider the
abutment loads that arise in retreat mining, and the first to be calibrated using an
extensive database of mining case histories. ALPS was followed by the Analysis of
Retreat Mining Stability (ARMPS) and the Analysis of Multiple Seam Stability (AMSS).
These methods incorporated other innovations including the Coal Mine Roof Rating
(CMRR), the Mark-Bieniawski pillar strength formula, and the pressure arch loading
model. They also built upon ever larger case history databases and employed more
sophisticated statistical methods.

The Analysis of Coal Pillar Stability (ACPS) now integrates all three of the older
software packages into a single pillar design framework. ACPS also incorporates the
latest research findings in the field of pillar design, including an expanded multiple seam
case history data base and a new method to evaluate Room-and-Pillar panels
containing multiple rows of pillars left in place during pillar recovery. ACPS also includes
updated guidance and warnings for users, and features upgraded Help files and
graphics.

References
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1.2 Structure of ACPS

ACPS users begin with the “Input Project Description” screen.  Two basic project types
can be defined. The “Development/Room-and-Pillar” module is used for the design of
main headings and production panels. Options for this type of project are “multiple
seam” and “pillar recovery.” The other type of project, a “Longwall Gate,” also has the
multiple seam option, though it is only applicable to the development phase of a gate
entry’s service life. 

The standard ACPS input screen for Development/ Room-and-Pillar projects allows the
user to input the depth of cover, the mining height, and other mining parameters that
define the pillar geometry. The new “advanced geometry” option allows all entry
spacings, crosscut spacings, and crosscut angles to be specified for each individual
pillar in a pillar row (Figure 1).

When the Retreat Option is selected, the user can specify (Figure 2):

· Whether there is just the active retreat mining in the panel being evaluated, or if there
are pre-existing worked-out panels (side gobs) on one or both sides of the panel,

· The extent of the active gob, and the width of any side gobs,
· The width(s) of the barrier pillar(s) separating the active panel from the side gobs, 
· The depth of any slab cuts taken from the barrier pillars, and
· Whether a row of bleeder pillars has been left within a side gob, and the width of those

bleeder pillars.

ACPS’ most significant new feature for retreat mining is that it can now simulate a wide
variety of leave pillar configurations within the active panel (Figure 3). 

The Multiple Seam Option provides two distinct evaluations of potential effects of a
multiple seam interaction. The first is a pillar Stability Factor (SF) calculation that
incorporates the multiple seam loads. This calculation requires data relating to the
previous seam mining, such as the interburden distance and the type of remnant
structure. 

The second multiple seam evaluation is of the entry stability, focusing on the expected
integrity of roof and rib conditions.  The ACPS calculations for this evaluation are slightly
different from the former AMSS calculations because they are based on an expanded
database and a new statistical analysis.

A new feature of ACPS is a “CMRR estimator” that helps users select appropriate
values of this critical entry stability parameter. The tool can be used when reliable
geologic data is available from core logs or underground observations, but no strength
testing has been conducted. The ACPS CMRR estimates are conservative and
coalfield-specific, and based on experience with the most common roof geologies
throughout the US. For example, the CMRR of Central Appalachian shale is estimated
to be about 45, while the estimates for weaker Illinois Basin shales are 38-40.
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The Longwall Gate project module closely resembles the former ALPS program on
which it is based. The primary purpose of the module is to help size pillars to maintain
the stability of the longwall tailgate.  A new feature of the Longwall Gate module is that
panel widths and abutment angles can now be specified for individual panels. The
CMRR estimator can also be used to help obtain input CMRR values, which are needed
to help determine the appropriate tailgate pillar SF. 

The multiple seam option is only available for the development phase of an ACPS
longwall gate entry project.  In fact, an equivalent analysis of a longwall gate
development can be conducted using either the Longwall Gate module or the
Development/Room-and-Pillar module.  The calculations for the longwall “bleeder,” and
“isolated” loading conditions are likewise now consistent in both modules.

1.3 ACPS Calculations Overview

Pillar design fundamentally consists of three basic steps:

· Estimating the loading that will be applied to the pillars during all the phases of
mining;

· Estimating the load-bearing capacity of the pillar system, and;
· Calculating "stability factors" (SF) by comparing the load to the load-bearing

capacity.

A final step is interpreting the SF.  In ACPS, the interpretation is founded in statistical
analysis of large databases of real world mining case histories.

ACPS determines the SF for a pillar system, not individual pillars.  Experience has
shown that a single pillar may be undersized, but if it can shed its excess load to
adjacent pillars, then overall stability can be maintained.  In the Longwall module, the
gate pillar system is evaluated.  In the Development/Room-and-Pillar module, an “active
mining zone” (AMZ) is first defined.  The width of the AMZ is equal to the width of the
mains or panel being evaluated, and the AMZ breadth is equal to five times the square
root of the depth of cover (Figure 5). For a panel beneath 900 feet of cover, for example,
the breadth of the AMZ is (5 * 30) = 150 feet.  In a retreat project, when leave pillars are
employed within an active retreat panel, ACPS re-defines the AMZ to include only those
pillars on the active pillar line (Figure 3).

The ACPS load bearing capacity calculation begins by determining the sizes of all the
pillars.  Then the strength of each pillar is determined, using the Mark-Bieniawski pillar
strength formula (Figure 4). The pillar strength is then multiplied by the pillar’s area to
obtain the pillar’s load bearing capacity. In an ACPS Longwall Gate project, the
individual pillar strengths are added together to determine the total load-bearing
capacity of the longwall gate entry system, expressed per foot of longwall gate.  The load
bearing capacity of the AMZ is determined by adding together the capacities of all the
pillars within the AMZ.  Projects using the Retreat Mining option also require the
calculation of the load bearing capacities of the barrier pillars.  
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The ACPS pillar load calculation begins with the tributary area approximation, which
states that the pillars carry the entire weight of the overburden directly above them
(Figure 6a). When the panel is at least 80 feet deeper than it is wide, however, a
“pressure arch” is assumed to form (Figure 6b).  The pressure arch transfers some of
the tributary area load to presumed solid coal or barrier pillars on either side of the
panel.  For a Development project, the pillars carry the load within the pressure arch.

Retreat mining causes abutment loads to be transferred to the pillars.  The “abutment
angle” concept is used to estimate the magnitude of these abutment loads in both
Retreat and Longwall Gate projects (Figure 7).  In the Multiple Seam module, a simple
two-dimensional numerical model that is incorporated into ACPS is used to estimate
the multiple seam loads.  The total load applied to the pillars is the sum of the
development, abutment, and multiple seam loads.

The SF is determined by dividing the load-bearing capacity of the pillars within the gate
entry system or AMZ by the total applied load. The design criteria suggested by NIOSH
are still considered to be appropriate.

1.4 Origins of ACPS

Pillars have been used since the earliest days of mining. The first scientific pillar design
method for US coal mines was developed more than a century ago. Yet as late as the
1980’s no design technique had achieved wide acceptance, and few pillars were truly
engineered (Mark, 2006). Most mines sized their pillars using local rules of thumb that
were based on past experience. Pillar failures (or “squeezes”) occurred relatively
frequently, particularly during pillar recovery, and were considered an inevitable part of
mining.

The advent of modern longwall mining added to the difficulties. Longwall gate pillars
were expected to maintain access to the longwall face, including the tailgate side of the
panel. Early pillar design methods did not consider the heavy abutment loads that are
generated by longwall mining, however. The 1984 Wilberg Mine Disaster, in which 27
miners were trapped by a headgate fire and could not escape because roof falls
blocked the tailgate entry, tragically illustrated the potential consequences of inadequate
gate entry ground control. 

The Analysis of Longwall Pillar Stability (ALPS) was developed in direct response to the
Wilberg Mine Disaster. The two dimensional “abutment angle” concept was developed
to provide estimates of retreat mining abutment loads, based on an extensive stress
measurement research program (Mark, 1990). ALPS used the Bieniawski formula to
estimate pillar strengths, though that formula is only appropriate for square pillars. A
Stability Factor (SF) was then calculated by comparing the load to the load-bearing
capacity of the longwall pillar system. 

When applied to the few available case histories, however, it was clear that the ALPS
pillar SF could not predict tailgate stability on its own. Roof support, entry width, and
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most critically, roof geology needed to be considered as well. The Coal Mine Roof
Rating (CMRR) rock mass classification was therefore developed so that geologic
factors could be quantified and integrated into the longwall pillar design process (Mark
and Molinda, 2005). Ultimately, a large data base of case histories was collected during
visits to longwall mines throughout the US, and modern multi-variate statistical
techniques were used for the first time to analyze the data (Mark et al., 1994). The study
resulted in simple ALPS design guidelines that considered all the key elements of the
tailgate stability problem.

Pillar design for room-and-pillar retreat mining was pursued next. During the decade
before 1994 pillar recovery operations had been associated with about 25% of all roof
fall fatalities underground, and in addition at least 12 massive pillar collapses had
occurred (Mark et al., 1997a; Mark et al., 1997b). The Analysis of Retreat Mining Pillar
Stability (ARMPS) was developed as a first step towards addressing these retreat
mining hazards. ARMPS employed the same “abutment angle” loading model as ALPS,
but extended it to three dimensions (Mark and Chase, 1997). It also modeled a wide
variety of mining geometries, including both production pillars and barrier pillars. The
original ARMPS database included 140 room-and-pillar mining case histories, and the
method explained the data very well up to depths of 650 feet or so. Two subsequent
research projects added another 500 cases to the database, mainly from mines with
depths of cover exceeding 750 feet. ACPS now incorporates the pressure arch loading
model, which was derived from statistical analysis of the case history data (Mark, 2010).

After more than a century of underground coal mining, many of the remaining coal
reserves in the US are affected by multiple seam interactions. These very complicated
phenomena can result in subsidence or stress transfers that cause roof falls, rib failure,
floor heave, and even coal bursts. The Analysis of Multiple Seam Stability (AMSS) was
developed to help mine planners assess the likelihood and potential severity of such
interactions. The AMSS database included 344 case histories representing the most
difficult conditions encountered in the Western and Central Appalachian coalfields (Mark
et al., 2007). Each of the case histories was defined by 22 variables, and a two
dimensional version of the numerical model LaModel (Heasley and Akingube, 2004)
was employed to estimate the multiple seam loads arising from an interaction. Logistic
regression was used to winnow these down to six key parameters which were then
combined into a design equation. AMSS has two components, one that predicts pillar
failures and the other entry stability issues.

By 2018, the ALPS, ARMPS, and AMSS pillar design methods were used in nearly
every underground coal mine in the US. Their success can be attributed to three main
factors (Mark, 2015):

· They are reliable because they are based on case histories which represent the broad
range of actual mining experience in the US,

· They are transparent because they employ concepts that can be easily understood
even by non-specialists, and

· They are user-friendly because the input parameters are readily at hand, and because
they have been available on high quality, easy-to-use computer platforms.
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Although no statistics on pillar failures are collected on a regular basis, it is clear that
improved pillar design has greatly reduced their incidence in US coal mines. Longwall
tailgate blockages have been rare in recent years, and typically only affect short
segments of the gateroad. Squeezes are very unusual today during pillar recovery, and
massive collapses are almost unheard of. The near-universal use of barrier pillars,
particularly under deep cover, has significantly reduced the risk of coal bursts. 

Better pillar design has also contributed to the greatly improved overall ground control
safety record of the US industry. The connection is clearest in the case of pillar recovery.
Once miners realized that squeezes resulted from inadequate pillars, and not from “poor
caving,” they were free to install more roof support and leave large final stumps. With
more effective ground control only one miner has been killed by a pillar recovery roof fall
in the decade since 2007, compared with 19 in the decade prior (Mark and Gauna,
2016).

There has been one significant blemish on this record, however. In 2007, the
catastrophic pillar failure at the Crandall Canyon Mine resulted in the deaths of six
miners and three rescuers. MSHA’s investigation found that a root cause of the disaster
was that the “dimensions of pillars within the active workings, as well as dimensions of
the adjoining barrier pillars, did not provide sufficient strength to withstand
stresses” (MSHA, 2008). The investigation further found that process used to design the
pillars was flawed because the “ARMPS analysis of the pillar dimensions was
inappropriately applied” and the numerical model analysis was “faulty.” 

The Crandall Canyon Disaster confirmed the need for reliable, user-friendly pillar design
techniques for coal mining. In the initial wake of the disaster, the ARMPS program was
strengthened with new pop-up user warnings and an expanded help file. Significant
technical improvements, notably the pressure arch loading model, were also made.
AMSS and ALPS were also upgraded, but not to the same extent.  ACPS now
integrates all three of the older packages into a single pillar design framework. 
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2 The File Menu

Description:

Use the File menu option to access various file management operations such as:

Creating New Files

Opening Existing Files

Saving Files

Saving Files under Different Names (Save As)

Setting up the Printer

Printing Files

Print Preview

Browsing Text Files

Exiting the Program

2.1 Creating New Files

Description:

Use the New option to erase the existing dataset (if any) from memory and create a
new (blank) dataset.  All related entries are set to their initial values. 

Notes:

· The program will prompt you whether to save the current file to disk.

2.2 Opening Existing Files

Description:

Use the Open option to load a file (dataset) into the program.

To use Open:

· Select the Open option from the File menu.  The program displays a listing of
the available files in the current data directory.

· Optionally, select a different drive or directory using the mouse or the cursor
control keys.

· Select or enter a filename.
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Notes:

· If the file extension is omitted, the default extension will be appended. 
· If the current dataset is not saved, the program will prompt whether to save

changes or not before discarding the current dataset.

2.3 Saving Files

Description:

Use the Save option to save an existing file (dataset) to the drive or directory from
which it was originally loaded.  Any changes that were made since the last time the file
was loaded will be saved back on the drive by overwriting the previous instance of that
file.  The filename remains the same and the project information remains loaded into
the program.

To use Save:

Select the Save option from the File menu.

Notes:

· If the file has never been saved using the Save As option, choosing Save
automatically displays the Save As dialogue box, which prompts for a filename
before saving it.

2.4 Saving Files under Different Names  (Save As)

Description:

Use the Save As option to save a file and give it a new name.

To use Save As:

· Select the Save As option from the File menu.  The program displays a listing of
the available files in the current data directory.

· Optionally, select a different drive or directory. 
· Select or enter a filename.

Notes:

· If the file exists, the program will prompt whether to overwrite the existing file.
· Use Save for a faster save operation.
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2.5 Setting Up the Printer

Description:

Use this option to select the printer to use for printing output and graphics. This printer
becomes the Windows default printer. 

To use this option:

Select Printer from the drop-down list and click on OK. 

2.6 Import ARMPS Project

Description:

Use the Import ARMPS Project option to load an ARMPS data file (dataset) into the
program.

To use Import ARMPS Project :

· Select the Import ARMPS Project  option from the File menu.  The program
displays a listing of the available files in the current data directory. *.ARM files
are filtered by default.

· Optionally, select a different drive or directory using the mouse or the cursor
control keys.

· Optionally, select a different file extension.
· Select or enter a filename.

Notes:

· ARMPS project files should be saved with the latest ARMPS program version.
· Importing an ARMPS project (file) will override any information already entered

into the ACPS program. 

2.7 Import ALPS Project

Description:

Use the Import ALPS Project option to load an ALPS data file (dataset) into the
program.

To use Import ALPS Project :

· Select the Import ALPS Project  option from the File menu.  The program
displays a listing of the available files in the current data directory. *.ALP files
are filtered by default.
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· Optionally, select a different drive or directory using the mouse or the cursor
control keys.

· Optionally, select a different file extension.
· Select or enter a filename.

Notes:

· ALPS project files should be saved with the latest ALPS program version.
· Importing an ALPS project (file) will override any information already entered

into the ACPS program. 

2.8 Import AMSS Project

Description:

Use the Import AMSS Project option to load an ALPS data file (dataset) into the
program.

To use Import AMSS Project :

· Select the Import AMSS Project  option from the File menu.  The program
displays a listing of the available files in the current data directory. *.AMS files
are filtered by default. 

· Optionally, select a different drive or directory using the mouse or the cursor
control keys.

· Optionally, select a different file extension.
· Select or enter a filename.

Notes:

· AMSS project files should be saved with the latest AMSS program version.
· Importing an AMSS project (file) will override any information already entered

into the ACPS program. 

2.9 Printing Files

Description:

Use the Print option to print the current dataset (file) from program memory to the
default Windows printer.  The default printer may be set using the Setting Up the Printer
menu option. 

Notes:

· The file is sent directly to the printer, without preview. Use the Print Preview
option to preview the file and then send it to the printer. 
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2.10 Print Preview

Description:

The user may navigate through the Print Preview window by using the vertical scroll
bar. 

The text in the window can be sent directly to the printer, or it can be copied to the
Windows clipboard for use in other applications.

Notes:

· This operation does not send any control characters to the printer. All output is
ASCII text. The text prints in "Courier" or "Courier New" font in size 9. If these
fonts are not available to the printer, then printed text will appear in the default
printer font.

· Each printed page is formatted with preset margins as follows:
ό left margin = 1 inch
ό top margin = 1 inch
ό bottom margin = 1 inch
ό right margin = variable

2.11 Browsing Text Files

Description:

Use the browse option to view a text (ASCII) file in a specified directory.  No editing is
allowed during browsing.

Use the pattern field to specify a file pattern (i.e. *.txt). The file window will be reset to
conform to the specified pattern. The default pattern is *.ACP. More than one pattern
can be applied using “;” as delimiter (e.g. *.txt;*.dxf).

Use the Set Font command button to specify the type and size of font for the displayed
text. These settings are saved in the ACPS.INI file.

Use the cursor control keys and vertical scroll bar to move within the browse window.

Use Ctrl-A to select all text and Ctrl-C to copy text to clipboard.

2.12 Exiting the Program

Description:
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Use the Exit option when ready to exit this program and return to the original
environment. The program will prompt the user to save the current file to disk, if not
already saved.
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3 Input Parameters

Description:
Use the Edit menu option to access various parameter input/edit forms such as:

Project Description

Development / Room-and-Pillar Parameters

Longwall Gate Parameters

3.1 Project Description

This is an arbitrary 300-character description of the model being generated.  It is a
recommended to make this a fairly detailed description of the specifics of the input file.
This text may be a single line of characters or may contain carriage returns.

The user can select the Project Type (Development / Room-and-Pillar or Longwall
Gate) and then the appropriate project options for each project type, i.e. Retreat Mining
and/or Multiple Seam. The current setup can also be set as the default setup by
checking the "Set as Default" checkbox. 

In addition, the user can set the type of units that will be used in the current project. The
program is designed to use two different sets of units:

· ft and lbs
· m and kN

Click on "Next form" to access the input forms for either Development / Room-and-
Pillar or Longwall Gate. 
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3.2 Development / Room-and-Pillar

Input Parameters: Development

Input Parameters: Defaults

Input Parameters: Retreat

Input Parameters: Multiple Seam

3.2.1 Input Parameters: Development

Entry Height
The entry height is the mining height or coal seam thickness (in feet or meters). Note
that the value entered here is the mined height of the pillars, which is not necessarily
equal to the seam thickness.  Some engineering judgment may be exercised when the
seam contains a lot of rock.  

The rock that is mined with the coal usually falls into one of two categories. The first is
weak claystone which should be considered part of the entry height, and includes:

· most in-seam rock,
· most floor rock, and
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· most draw rock beneath a rider seam.

On the other hand, competent roof rock that is mined solely for equipment clearance is
often stronger than the coal.  The thickness of such “cap rock” can be reduced by 50%
in the entry height calculation.  In other words, if 12 inches of competent cap rock is
mined, only 6 inches should be added to the seam thickness to obtain the entry height. 
This guideline was used in the analysis of the ACPS data base.
A special case might be a thick parting that includes some strong rock.  In that case,
the strong portion of the parting could be subject to the “50% rule” described above.  A
geologist or ground control professional could help determine how much of the parting
is actually competent rock.

Depth of Cover
Determining the depth of cover to use in an ACPS analysis can be problematic in
mountainous terrain.  A study using the numerical model code LAMODEL indicated
that a good estimate of the average AMZ stress could be achieved by computing the
average depth of the elements within the AMZ.  Based on this finding, the
recommended procedure for estimating depth of cover for an ACPS analysis is:

1. Locate the point within the panel or section being analyzed where the depth of cover
is greatest.

2. Draw a perpendicular line across the row of pillars that includes the point of the
maximum depth of cover.

3. Define a zone that extends 200 ft (60 m) inby and 200 ft (60 m) outby the deepest
cover line and determine the minimum depth of cover within that zone.

The ACPS depth of cover (H) is then the arithmetic average of those minimum and
maximum depths (Figure 8). This guideline was used in the analysis of the ACPS
database.

Entry Width
The entry width is the width of the entries. Crosscuts are assumed to be the same width
as the entries (in feet or meters). Note that when the case histories in the ACPS data
base were analyzed, the nominal entry widths were used, rather than widths adjusted
for rib sloughage.

Crosscut Spacing
The center-to-center crosscut spacing helps define the pillar dimensions.  Only one
spacing is normally entered (in feet or meters).  When the “advanced geometry” option
is enabled different crosscut spacings can be specified for each column of pillars
(Figure 1).

Crosscut Angle
The crosscut angle is measured between the entry and the crosscut.  When the
crosscuts are perpendicular to the entries, the crosscut angle is 90 degrees.  

Different crosscut angles may be specified for each column of pillars when the
“advanced geometry” option is enabled (Figure 1).  However, the orientation of the
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crosscut angle is not significant, only the angle it makes with the entries.  So if the belt
entry is the middle entry, and the crosscuts are mined in both directions away from the
belt at 60 degree angles, then only one value of the crosscut angle needs to be entered
(Figure 2).

Number of Entries
The user should specify the number of entries within the active panel.  When setting this
number, the corresponding number of center-to-center spacing input boxes
automatically appears. The maximum number of entries is limited to ten in a
Development/Room-and-Pillar project, and five in a longwall gate project.

Entry Spacings
The center-to-center entry spacings help define the pillar widths.  The entry spacings
are entered in order, starting from the first longwall panel or side gob.  Note that pillar
column #1 is the column between the first and second entry, pillar column #2 is the
column between the second and third entry, and so on (in feet or meters).  Changing
the numbering sequence will not affect the stability factors calculated by ACPS, but it
can change which leave pillars are specified. 

Advanced Geometry
When the Advanced Geometry option is checked, the user can specify different
crosscut spacings and different cross cut angles for every pillar row  

Retreat Mining
The Retreat Mining option should be checked to provide access to the "Retreat" tab of
the input form.  When the Retreat Mining option is not enabled, stability factors are
calculated for the development case only. See Input Parameters: Retreat.

Multiple Seam
The Multiple Seam option should be checked to provide access to the "Multiple
Seam" tab of the input form.  When the Multiple Seam option is not enabled, stability
factors are calculated for the single seam case only. 
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3.2.2 Input Parameters: Defaults

Note:  Users generally should not adjust the values of the default parameters.   The
statistical analysis that went into the development of the ACPS design criteria
assumed the default values for all the case history data.  Using different values
invalidates the design criteria.

In Situ Coal Strength
The in situ coal strength is expressed in psi or MPa. The default value is 900 psi or 6.2
MPa. Research (Mark and Barton, 1997) has shown that 900 psi is a better
approximation than can normally be obtained from coal testing.  In general, the only
valid reason to adjust the in situ coal strength is if back-analysis of numerous site-
specific case histories indicates that it is significantly different from 900 psi.

Breadth of the AMZ (Development / Room-and-Pillar projects only)
The breadth of the AMZ is five times the square root of the depth of cover. The width of
the AMZ is the sum of all entry center-to-center spacing. See Active Mining Zone (AMZ)
/ Pillar System for more information.

Unit Weight of the Overburden
The unit weight of the overburden is expressed in pcf or kN/m 3. The default value is
162 pcf or 25.47 kN/m3.

Pressure Arch Factor (Fpa)
The Pressure Arch Factor (Fpa) determines how much of the load is initially transferred
from the production pillars in the AMZ to the solid coal or barrier pillars.  The default
value of the Fpa is 1.0 when the panel width exceeds than the depth of cover plus 80 ft.
 For narrower panels, the default value is:

Fpa = 1 - (0.28 * Ln((H) / Wt))

3.2.3 Input Parameters: Retreat

Loading Condition
The loading condition (LC) defines the number of gob areas. Four possible loading
conditions can be modeled in ACPS, as illustrated in Figure 9.

· LC1:  Development Load: First mining only, no gob is present.
· LC2:  One Active Retreat Section: Development load plus a front abutment load from

pillar recovery in the active panel. 
· LC3:  Active Retreat Section and One Side Gob: Development load plus a front

abutment load from the active gob, plus a side abutment load from one previously-
mined side gob.

· LC4:  Active Retreat Section and Two Side Gobs: Development load plus an
abutment load from the active gob area, plus two additional abutment loads from two
previously-mined side gobs.
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Note that if there is no active pillar recovery, the effects of previously-mined side gobs
may be modeled by setting the extent of the active gob equal to zero.

Leave Pillars
Columns of “leave pillars” can be left in the active panel gob as shown in Figure 3. One
or more pillars can be left on either or both sides of the panel by checking the
appropriate boxes on the input screen.  Pillars can also be left in previously extracted
side gobs (Figure 10).  Row “A” can be left in the first side gob, and row “B” in the
second side gob. The width of the pillars in rows “A” and “B” are input on the “Retreat”
screen.  These widths are of solid coal, not center-to-center.  The crosscut spacings for
rows “A” and “B” are assumed to be the same as the other production pillars (or pillar
row number one if advanced geometry is employed), and the crosscut angle is fixed at
90 degrees.  ACPS assumes that the row ”A” and row “B” leave pillars may add to the
load-bearing capacity of the adjacent barrier pillars.  Therefore, they cannot be enabled
unless a solid barrier pillar is left in place. See Barrier Pillar Calculations for more
information.

Extent of Gob (Active Gob)
The extent of the active gob is measured perpendicular to the pillar line (i.e., it is
normally the length of the gob, from the start of pillar recovery to the active pillar line).
For the side gobs, the gob extents are measured parallel with the pillar line (i.e., they
are normally the panel widths, minus any leave pillars that may have been left within
them).  In both cases, they are measured rib-to-rib (not entry center-to-center).

Barrier Pillar Width
The width of the barrier that should be entered is solid coal, not entry center-to-center
(in feet or meters).  The width that is entered is the width prior to taking any slab cuts
(Figure 2).

Depth of a Slab Cut
The slab cut in ACPS is taken from a barrier pillar (Figure 2). Slab cuts may only be
input in Loading Conditions 3 and 4, because there are no barrier pillars in Loading
Condition 2.  Studies have shown that when a slab cut is taken from solid coal, little
additional load is applied to the AMZ.  Since a slab cut from the solid doesn’t affect the
SF, ACPS does not include the option to directly input a slab cut from the solid.   While
it is not recommended, slab cuts from the solid may be modeled indirectly by entering
Loading Condition 3 or 4, and then setting the extent of the gob on the solid side to
zero.  Slab cuts also cannot be taken from a barrier pillar if leave pillars are adjacent to
it.

Abutment Angles
The abutment angle determines how much load is carried by gob.  Figure 7 shows the
abutment loading for subcritical and supercritical panel widths. The abutment angle has
been calibrated from measurements of longwall abutment stresses, not from
observations of caving angles or subsidence.  These stress measurements indicated
that an abutment angle of 21° is appropriate for normal caving conditions as shown by
Mark (1990) and Colwell et al. (1999).  Although the value of 21° was used to analyze
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all the case histories in the ACPS data base, in rare cases it may be appropriate to
change the abutment angle.  For example, if it is known that no caving has occurred,
then the abutment angle may be set to 90° to simulate zero load transfer to the gob. 
Other research on the abutment angle can be found in Tulu et al. (2012) and Hill et al.
(2015).

3.2.4 Input Parameters: Multiple Seam

Active UNDER Previous Mining (Undermining)
Undermining occurs when the upper seam has been mined first and the lower seam is
the active seam (Figure 11).

Active OVER Previous Mining (Overmining)
Overmining occurs when the upper seam is extracted after mining is complete in the
lower seam (Figure 12).

Interburden Thickness
The thickness of the strata separating the active seam from previously mined seam.

Seam Thickness (Previous Seam)
The previous seam thickness is the mining height (in feet or meters). Note that the
value entered here is the mined height of the pillars, which is not necessarily equal to
the coal thickness.  This value is used as an input to the Lam2D calculation of the
multiple seam stress.

Remnant Structures
Remnant Structures encountered in multiple seam mining can generally be classed as
either:

· gob-solid boundaries, with gob on one side, or;
· isolated remnant pillars that are surrounded by gob on two or more sides

Figure 13 shows that while a gob-solid boundary carries a single, distributed abutment
load, an isolated remnant pillar is subjected to two, overlapping abutments. As a result,
the stress concentration on an isolated remnant pillar is usually significantly larger than
that on a gob-solid boundary, and its impact on underlying seams proportionally
greater.  In many cases, it is obvious how to classify a remnant structure.  In other
cases, some engineering judgment is required to determine whether the structure
should be treated as a gob-solid boundary or an isolated remnant pillar.  Two common
examples:

· Development pillars adjacent to a mined-out area:  The boundary between a gob
area and several rows of development pillars is normally considered a gob-solid
boundary.

· Longwall chain pillars between two mined-out longwall panels are normally modeled
as an isolated remnant pillar.  In AMSS, a chain pillar system can be approximated
by combining the chain pillars into a single remnant pillar.  For example, if the chain
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pillar system consists of two, 80-ft wide pillars, it can be modeled in AMSS as one
160 ft wide remnant. Keep in mind that the purpose of AMSS is to provide a simple
first-pass analysis, so there is no need to model details like the middle entries or
crosscuts of the chain pillar system.

Sometimes it is difficult to determine if a wide remnant pillar should be treated as one
isolated remnant or as two gob solid boundaries. The rule of thumb used in AMSS is
that if the pillar’s width exceeds 5 times the square root of the depth of cover, then the
pillar is so large that the abutment loads probably do not overlap, and it should be
considered as two gob solid boundaries.  Another problem can arise with a thin
isolated remnant.  If its Stability Factor is less than about 0.5, then it may have yielded
and may not be able to transfer significant loads.  Figure 14 shows the approximate
minimum and maximum dimensions for a pillar to be considered an isolated remnant.

Supplemental Support
Supplemental Support can be cable bolts, trusses, superbolts, steel posts, or some
other type.  In the ACPS data base, the density of the supplemental support was
generally sufficient to carry 5-8 ft of rock load.  For example, two, 30 ton capacity cable
bolts every 4-8 ft along the entries.

Gob Width
The gob width is the least dimension of the gob in the previously-mined seam.  For an
old longwall gob, the width is almost always the face length.  Room-and-pillar gob
areas can assume many shapes, and so some engineering judgment may be
necessary to select the appropriate minimum gob width.

Coal Mine Roof Rating (CMRR)
The Coal Mine Roof Rating (CMRR) is a 0-100 rating scale that measures the
structural competence of mine roof.  The CMRR can be calculated from underground
exposures, or from exploratory drill core using a combination of geotechnical logging
and point load testing.  A NIOSH program to help in calculating the CMRR is available
at http//www.cdc.gov/niosh/mining/.  The “CMRR Estimator” provides some general
values for some of the most common roof geologies found in the different US
coalfields.  

3.3 Longwall Tailgate

Input Parameters: Development

Input Parameters: Defaults

Input Parameters: Longwall Retreat

Input Parameters: Multiple Seam
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3.3.1 Input Parameters: Development

Entry Height
The entry height is the mining height or coal seam thickness (in feet or meters). Note
that the value entered here is the mined height of the pillars, which is not necessarily
equal to the seam thickness.  Some engineering judgment may be exercised when the
seam contains a lot of rock.  

The rock that is mined with the coal usually falls into one of two categories. The first is
weak claystone which should be considered part of the entry height, and includes:

· most in-seam rock,
· most floor rock, and
· most draw rock beneath a rider seam.

On the other hand, competent roof rock that is mined solely for equipment clearance is
often stronger than the coal.  The thickness of such “cap rock” can be reduced by 50%
in the entry height calculation.  In other words, if 12 inches of competent cap rock is
mined, only 6 inches should be added to the seam thickness to obtain the entry height. 
This guideline was used in the analysis of the ACPS data base.
A special case might be a thick parting that includes some strong rock.  In that case,
the strong portion of the parting could be subject to the “50% rule” described above.  A
geologist or ground control professional could help determine how much of the parting
is actually competent rock.

Depth of Cover
Determining the depth of cover to use in an ACPS analysis can be problematic in
mountainous terrain.  A study using the numerical model code LAMODEL indicated
that a good estimate of the average AMZ stress could be achieved by computing the
average depth of the elements within the AMZ.  Based on this finding, the
recommended procedure for estimating depth of cover for an ACPS analysis is:

1. Locate the point within the panel or section being analyzed where the depth of cover
is greatest.

2. Draw a perpendicular line across the row of pillars that includes the point of the
maximum depth of cover.

3. Define a zone that extends 200 ft (60 m) inby and 200 ft (60 m) outby the deepest
cover line and determine the minimum depth of cover within that zone.

The ACPS depth of cover (H) is then the arithmetic average of those minimum and
maximum depths (Figure 8). This guideline was used in the analysis of the ACPS
database.

Entry Width
The entry width is the width of the entries. Crosscuts are assumed to be the same width
as the entries (in feet or meters). Note that when the case histories in the ACPS data
base were analyzed, the nominal entry widths were used, rather than widths adjusted
for rib sloughage.
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Crosscut Spacing
The center-to-center crosscut spacing helps define the pillar dimensions.  Only one
spacing is normally entered (in feet or meters).  When the “advanced geometry” option
is enabled different crosscut spacings can be specified for each column of pillars
(Figure 1).

Crosscut Angle
The crosscut angle is measured between the entry and the crosscut.  When the
crosscuts are perpendicular to the entries, the crosscut angle is 90 degrees.  

Different crosscut angles may be specified for each column of pillars when the
“advanced geometry” option is enabled (Figure 1).  However, the orientation of the
crosscut angle is not significant, only the angle it makes with the entries.  So if the belt
entry is the middle entry, and the crosscuts are mined in both directions away from the
belt at 60 degree angles, then only one value of the crosscut angle needs to be entered
(Figure 2).

Number of Entries
The user should specify the number of entries within the active panel.  When setting this
number, the corresponding number of center-to-center spacing input boxes
automatically appears. The maximum number of entries is limited to ten in a
Development/Room-and-Pillar project, and five in a longwall gate project.

Entry Spacings
The center-to-center entry spacings help define the pillar widths.  The entry spacings
are entered in order, starting from the first longwall panel or side gob.  Note that pillar
column #1 is the column between the first and second entry, pillar column #2 is the
column between the second and third entry, and so on (in feet or meters).  Changing
the numbering sequence will not affect the stability factors calculated by ACPS, but it
can change which leave pillars are specified. 

Advanced Geometry
When the Advanced Geometry option is checked, the user can specify different
crosscut spacings and different cross cut angles for every pillar row  

Multiple Seam
The Multiple Seam option should be checked to provide access to the "Multiple
Seam" tab of the input form.  When the Multiple Seam option is not enabled, stability
factors are calculated for the single seam case only. Note that the Multiple Seam option
only applies to Development of the gate entries.

3.3.2 Input Parameters: Defaults

Note:  Users generally should not adjust the values of the default parameters.   The
statistical analysis that went into the development of the ACPS design criteria
assumed the default values for all the case history data.  Using different values
invalidates the design criteria.
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In Situ Coal Strength
The in situ coal strength is expressed in psi or MPa. The default value is 900 psi or 6.2
MPa. Research (Mark and Barton, 1997) has shown that 900 psi is a better
approximation than can normally be obtained from coal testing.  In general, the only
valid reason to adjust the in situ coal strength is if back-analysis of numerous site-
specific case histories indicates that it is significantly different from 900 psi.

Unit Weight of the Overburden
The unit weight of the overburden is expressed in pcf or kN/m 3. The default value is
162 pcf or 25.47 kN/m3.

Pressure Arch Factor (Fpa)
The Pressure Arch Factor (Fpa) determines how much of the load is initially transferred
from the production pillars in the AMZ to the solid coal or barrier pillars.  The default
value of the Fpa is 1.0 when the panel width exceeds than the depth of cover plus 80 ft.
 For narrower panels, the default value is:

Fpa = 1 - (0.28 * Log((H) / Wt))

3.3.3 Input Parameters: Longwall Retreat

Panel Widths 
The panel width is the width of the longwall panel (or face length), measured from the
center of the headgate entry to the center of the tailgate (in feet or meters).  The panel
widths can be specified individually for the first and second panels.  

Note1:  In ACPS, the “first longwall panel” refers to the panel on the belt entry side of the
gate system being evaluated (the headgate entry side), and the “second panel” refers to
the panel on the other side (the tailgate entry side) of the same gate system. 

Note2: When the first panel width is set to zero, the second panel width automatically
defaults to zero and input is disabled.

Abutment Angles
The abutment angles may be specified for each individual panel.  The default value is 21
degrees (Figure 7).

Users generally will not need to adjust the abutment angle, which determines the
magnitude of the abutment loads, and the in situ coal strength, which is used in the
calculation of the pillar load-bearing capacity.  The research that went into the
development of ALPS indicated that these two variables should be set at 21 degrees
and 900 psi, respectively (Mark, 1990).  In particular, research has found that there is
no correlation between the performance of longwall pillars and the uniaxial
compressive strength of coal specimens (Mark and Barton, 1997; Mark 1999).

Coal Mine Roof Rating (CMRR)
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The Coal Mine Roof Rating (CMRR) is a 0-100 rating scale that measures the structural
competence of mine roof.  The CMRR can be calculated from underground exposures,
or from exploratory drill core using a combination of geotechnical logging and point load
testing.  A program to help in calculating the CMRR is available at
http//www.cdc.gov/niosh/mining/.  The “CMRR Estimator” provides some general values
for some of the most common roof geologies found in the different US coalfields.  

Stability Factor (SF) for a Longwall Gate Project
The suggested ACPS SF for a Longwall Gate project is supplied by ACPS, not input by
the user.  Research suggests that, all else being equal, weaker roof requires larger
pillars (Mark, 1999).  The suggested ACPS Longwall Gate SF is determined by the
Coal Mine Roof Rating (CMRR) :

SF = 2.00 - 0.016 CMRR

3.3.4 Input Parameters: Multiple Seam

Active UNDER Previous Mining (Undermining)
Undermining occurs when the upper seam has been mined first and the lower seam is
the active seam (Figure 11).

Active OVER Previous Mining (Overmining)
Overmining occurs when the upper seam is extracted after mining is complete in the
lower seam (Figure 12).

Interburden Thickness
The thickness of the strata separating the active seam from previously mined seam.

Seam Thickness (Previous Seam)
The previous seam thickness is the mining height (in feet or meters). Note that the
value entered here is the mined height of the pillars, which is not necessarily equal to
the coal thickness.  This value is used as an input to the Lam2D calculation of the
multiple seam stress.

Remnant Structures
Remnant Structures encountered in multiple seam mining can generally be classed as
either:

· gob-solid boundaries, with gob on one side, or;
· isolated remnant pillars that are surrounded by gob on two or more sides

Figure 13 shows that while a gob-solid boundary carries a single, distributed abutment
load, an isolated remnant pillar is subjected to two, overlapping abutments. As a result,
the stress concentration on an isolated remnant pillar is usually significantly larger than
that on a gob-solid boundary, and its impact on underlying seams proportionally
greater. In many cases, it is obvious how to classify a remnant structure.  In other cases,
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some engineering judgment is required to determine whether the structure should be
treated as a gob-solid boundary or an isolated remnant pillar.  Two common examples:

· Development pillars adjacent to a mined-out area:  The boundary between a gob
area and several rows of development pillars is normally considered a gob-solid
boundary. 

· Longwall chain pillars between two mined-out longwall panels are normally modeled
as an isolated remnant pillar.  In AMSS, a chain pillar system can be approximated by
combining the chain pillars into a single remnant pillar.  For example, if the chain pillar
system consists of two, 80-ft wide pillars, it can be modeled in AMSS as one 160 ft
wide remnant. Keep in mind that the purpose of AMSS is to provide a simple first-
pass analysis, so there is no need to model details like the middle entries or crosscuts
of the chain pillar system.

Sometimes it is difficult to determine if a wide remnant pillar should be treated as one
isolated remnant or as two gob solid boundaries. The rule of thumb used in AMSS is
that if the pillar’s width exceeds 5 times the square root of the depth of cover, then the
pillar is so large that the abutment loads probably do not overlap, and it should be
considered as two gob solid boundaries. Another problem can arise with a thin
isolated remnant.  If its Stability Factor is less than about 0.5, then it may have yielded
and may not be able to transfer significant loads.  Figure 14 shows the approximate
minimum and maximum dimensions for a pillar to be considered an isolated remnant.

Gob Width
The gob width is the least dimension of the gob in the previously-mined seam.  For an
old longwall gob, the width is almost always the face length.  Room-and-pillar gob
areas can assume many shapes, and so some engineering judgment may be
necessary to select the appropriate minimum gob width.

Coal Mine Roof Rating (CMRR)
The Coal Mine Roof Rating (CMRR) is a 0-100 rating scale that measures the
structural competence of mine roof.  The CMRR can be calculated from underground
exposures, or from exploratory drill core using a combination of geotechnical logging
and point load testing.  A NIOSH program to help in calculating the CMRR is available
at http//www.cdc.gov/niosh/mining/.  The “CMRR Estimator” provides some general
values for some of the most common roof geologies found in the different US
coalfields.  
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4 CMRR Estimator

A new feature of ACPS is a “CMRR estimator” that helps users select appropriate
values of this critical entry stability parameter. The tool can be used when reliable
geologic data is available from core logs or underground observations, but no strength
testing has been conducted. The ACPS CMRR estimates are conservative and
coalfield-specific, and based on experience with the most common roof geologies
throughout the US. For example, the CMRR of Central Appalachian shale is estimated
to be about 45, while the estimates for weaker Illinois Basin shales are 38-40.

The CMRR estimator can be accessed from the Multiple Seam tab of either the
Development / Room-and-Pillar or the Longwall Tailgate input forms. In addition the
estimator can be accessed through the Longwall Retreat tab of the Longwall Tailgate
input form.
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5 Interpretation of ACPS Stability Factors

Types of Ground Control Failure

Stability Factor for the Development/Room and Pillar Module

Stability Factor for the Longwall Gate Module

Multiple Seam Option

5.1 Types of Ground Control Failure

ACPS can help prevent ground control failures that are responsible for hazardous
conditions underground, including:

· Pillar Squeezes, which are non-violent events that may take hours, days, or even
weeks to develop.  Squeezes are the most common type of pillar failure, and generally
result in significant roof-to-floor convergence over a large area.  They are also
commonly associated with roof instability, floor heave, and rib falls.  Because they
develop slowly, however, the affected area is usually abandoned before there are any
injuries. MSHA fatality reports show that no mineworkers have been killed by a pillar
squeeze in at least the past 35 years.

· Pillar Collapses, which are relatively rare events that occur when a large number of
overloaded pillars fail almost simultaneously.  Pillar collapses often result in a
destructive airblast.  Most collapses in the US have occurred under low cover (less
than 500 ft (150 m)), and they have been associated with the slender pillar remnants
that have been left in worked-out gob areas after partial pillar recovery operations.  

· Multiple Seam Interactions:  A multiple seam interaction may occur even when the
pillar SF is adequate (for example, a single-entry tunnel with solid coal on either side
can be affected by an interaction).  The severity of a multiple seam interaction
depends on a number of factors, including the location of the past mining relative to
the active mining, the type of remnant, and the roof quality and installed support in the
active mine.

· Longwall Tailgate Blockages, which may be caused by roof instability, floor heave,
and/or rib falls, and are often associated with inadequately sized pillars.

· Coal Bursts, which can affect just a small portion of a single pillar, or may destroy
many pillars at once.  The likelihood of a large burst affecting multiple pillars can be
greatly reduced when properly sized pillars and barrier pillars are used.  Bursts have
many causes, however, and not all of them can be eliminated by pillar design.  A pre-
mining burst risk analysis should be conducted whenever a potential for coal bursts
exists (Mark and Gauna, 2015).
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5.2 Stability Factor for the Development/Room and Pillar Module

ACPS stability factors (SF) are obtained by dividing the total load-bearing capacity of
the pillar system by the total load applied to it.  The critical step is the interpretation of
the SF.  ACPS has been verified through back analysis of mining case histories. Three
separate databases have been collected:

· Development and retreat mining:  More than 600 case histories were obtained
from 10 states, almost all from mine visits (Mark, 2010). They cover an extensive
range of geologic conditions, roof rock cavability characteristics, extraction methods,
depths of cover, and pillar geometries. Ground conditions in each case history have
been categorized as being either satisfactory or unsatisfactory.

· Multiple seam: The original database included 344 case histories from 36 coal
mines, all from the Western or Central Appalachian coalfields (Mark et al., 2007).  In
2018, 53 cases from three Northern Appalachian mines were added (Mark and
Agioutantis, 2018).

· Longwall tailgates: Verified by back-analysis of more than 100 actual longwall
mining case histories (Mark et al., 1994).  

Stability Factors for the Development/Room-and-Pillar Module

The original ARMPS data base, published in 1997, consisted of approximately 150
case histories, representing a broad range of cover depths.  About half of these were
considered “successful” because the entire panel was recovered without significant
ground control incident.  Analysis indicated that when the depth of cover was less than
650 ft, an SF of about 1.5 was a reasonable starting point.  However, for deep cover
cases, two discrepancies were apparent:

· Many panels with an SF well below 1.5 were successful, and;
· No single SF was able to separate the successful from the unsuccessful cases.

Later research showed that the “pressure arch” theory adequately explains these
discrepancies (Mark, 2010). The “pressure arch” can reduce the load applied to the
production pillars, while increasing the load applied to the barrier pillars (see Figure 6b).
When the loads in the case history data base were adjusted to account for the pressure
arch, an SF of about 1.5 appears to be appropriate for the deeper cover conditions as
well as shallow ones (see Figure 17). These suggested design guidelines are shown in
Table 1.

Table 1.  ACPS 2010 suggested design guidelines.

Depth of Cover (ft) ACPS SF Barrier Pillar SF

<650 1.5 -

>650 1.5 1.5
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In the ACPS Retreat option, barrier pillar behavior is directly linked to the pillars in the
AMZ.  If the barrier pillars are too small, large loads are transferred back to the pillars in
the AMZ (Figure 18), resulting in low ACPS SF values.  Therefore, the barrier pillar SF
is an integral part of the design criteria as shown in Table 1.

The data also show that when deep cover panels are adequately shielded from side
abutment loads with barrier pillars, the overall likelihood of success is greatly increased.
Therefore, alternative criteria are suggested in Table 2 and Figure 19. To provide
added assurance that the pressure arch is functioning effectively, it is recommended
that these alternative criteria only be used where the panel width is limited to 425 ft, and
where the barrier pillar has been reinforced by increasing its SF to at least 2.0.

Table 2.  Alternative ACPS 2010 suggested design guidelines with narrow panels and
reinforced barrier pillars.

Depth of Cover
(ft)

Panel Width
(ft) ACPS SF

Barrier Pillar
SF

650 -1,000 < 425
1.5-[0.20*((Depth-

650)/350)]
> 2.0

>1,000 < 425 1.30 > 2.0

It is important to note that both the 2010 and 2002 models misclassify some pillar failure
case histories as successes.  All of these misclassifications were pillar squeezes, not
the more hazardous collapses.  Pillar collapses represent a much more direct threat to
miners because they occur with little or no warning.  The pillar design method should
therefore provide a higher margin of safety for collapses than is necessary for squeezes.
 
Preventing Massive Pillar Collapses

Most of the pillar failures included in the ACPS data base are “squeezes” in which the
section converged over hours, days, or even weeks.  Another important subset is the
group of 13 massive pillar collapses (Mark et al., 1997).  These occurred when
undersized pillars failed and rapidly shed their load to adjacent pillars, which in turn
failed.  The consequences of such chain reaction-like failures typically include a
powerful, destructive, and hazardous airblast.

Data collected at 12 massive collapse sites revealed that the ACPS SF was less than
1.5 in every case.  What really distinguished the sudden collapses from the slow
squeezes, however, was the pillar’s w/h ratio.  Every massive pillar collapse involved
slender pillars whose w/h was 3.0 or less.

Two alternative design strategies are available to prevent massive pillar collapses:

· Prevention: With the prevention approach, the panel pillars are designed so that
collapse is highly unlikely.  This can be accomplished by increasing either the SF of
the pillars to exceed 2.0, or increasing their w/h ratio to be at least 4.0.
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· Containment: In this approach, high-extraction is practiced within individual
compartments that are separated by barriers.  The size of the area supported by
slender pillars should not exceed 3.2 acres (about 140,000 square ft), and the
minimum dimension of the area should not exceed 300 ft.  The slender pillars are less
likely to collapse within such a small compartment, but even if they do, the
consequences are not great.  The barriers must be strong enough to truly isolate the
compartments form each other (though the barriers may consist of rows of
development pillars that are not split on retreat).

5.3 Stability Factor for the Longwall Gate Module

The ACPS Longwall Gate SF used in design should be based on the structural
competence of the mine roof, measured by the Coal Mine Roof Rating (CMRR).  The
research showed that, all else being equal, weaker roof requires larger pillars.  The
suggested ACPS Longwall Gate SF is:

SF =  = 2.00 - 0.016 CMRR

This equation was also derived from statistical analysis of the same longwall case
history data base (Colwell et al., 1999).

The data from the longwall case histories also showed strong relationships between the
CMRR and entry width (Figure 20), and between the CMRR and primary support (Figure
21).

5.4 Multiple Seam Evaluation

The goal of the ACPS multiple seam option is to help identify the location and likely
severity of multiple seam interactions.  The Multiple Seam Option provides two distinct
evaluations of potential effects of a multiple seam interaction. The first is a pillar Stability
Factor (SF) calculation that incorporates the multiple seam loads. Many of the failed
cases in the multiple seam data base involved pillars whose Multiple Seam Pillar
Stability Factors appeared inadequate.  

The second multiple seam evaluation is of the entry stability, focusing on the expected
integrity of roof and rib conditions.  The ACPS design equation predicts the critical
thickness of the interburden (INTcrit) required to minimize the likelihood of a multiple
seam interaction:  

INTcrit = 74*TVS – 43*UO – 50*EX + 56* REMPIL – 97*(lnCMRR20) + 320

where:

TVS = Total vertical stress on the critical pillar (thousands of psi) 
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UO= 1 for undermining, 0 for overmining
INT = interburden (ft)
EX = 1 for supplemental support, 0 for none
REMPIL = 1 for isolated remnant pillar, 0 for gob-solid boundary 
lnCMRR20 = ln (CMRR-20) 

In some cases the INTcrit equation can predict a negative value of the critical
interburden thickness. Therefore, a logistic regression model was determined using the
log of the critical interburden (INTcritLN) in place of the interburden per se:

INTcritLN = EXP[0.87*TVS – 0.45*UO – 0.60 *EX + 0.62* REMPIL –
1.22*(lnCMRR20) + 7.41]

Three predicted outcomes are possible:

a) GREEN: If INTcrit is significantly less than the actual interburden without
supplemental support, then a major multiple seam interaction can be considered
unlikely.

b) YELLOW: If the actual interburden is less than INTcrit without supplemental support,
but greater than INTcrit with supplemental support, then adding a pattern of cable
bolts or other equivalent supplemental support could greatly reduce the probability of
a major interaction.

c) RED:  If INTcrit even with supplemental support is greater than the actual interburden
thickness, then a major interaction should be considered likely, and it may be
desirable to avoid the area entirely.

The results of this analysis are printed in the output, and they are also displayed visually
on the “View Results” pop-up screen.  

This equation has been incorporated into a step-by-step ACPS multiple seam design
procedure that allows mine planners to evaluate each potential interaction and take
steps to reduce the risk of ground control failure (Mark et al. 2007).

5.5 Example 1

The following example illustrates the two separate analyses that ACPS conducts under
multiple seam conditions. Adequate pillar size is a necessary, but not sufficient,
condition for multiple seam stability.  Even if pillars are sized adequately and the stability
factor is above the recommended thresholds, a multiple seam interaction could still
damage the entries.

The scenario shown below has a typical 5-entry development case with no retreat, but
close to previously mined seams.
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Results show that although the development stability factor exceeds the suggested
value, multiple seam conditions may adversely impact the stability of these workings.
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5.6 Example 2

Question:

ABC Mining company plans to do multiple seam mining. They want to mine the X seam
underneath the previously mined Y seam. 

What should be the input for the gob extent since there are no pillared out areas in the Y
seam? The Y seam was only developed (no pillaring). The program will not take zero as
gob extend. Also, is it possible roof falls in the Y seam could cause remnant issues? 

Should this be handled as a Gob Solid layout or a Remnant Pillar layout? 

Answer:

In general if there is only development mining in the previous seam, then there is no
need to conduct a multiple seam analysis.  So long as the pillars in the previous seam
are intact and carrying load, and the interburden is greater than 30 feet or so, then the
vertical stress in the active seam should be pretty uniform just as if no previous mining
had taken place.  The caveats are:

1. Is it possible that the pillars in the previous seam not be carrying their load?  This can
occur if the pillars are small (check their SF) or if the floor could have failed.  If a
squeeze has developed in the previous seam, then the old pillars might be behaving
as a pseudo gob, transferring remnant loads to the active seam.  In this case ACPS
(multiple seam) can be used, treating the extent of the squeezed area (pseudo gob)
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as the gob extent.  In general, the edges of the pseudo gob would be considered
gob-solid boundaries.

2. If the seams are quite close together (less than 30 feet or so), there may be an “ultra
close” interaction.  ACPS (multiple seam) does not address ultra close interactions; a
special analysis needs to be performed.

Roof falls do not normally cause multiple seam interactions, so long as the pillars are
intact.
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6 Calculations

· ACPS Development/Room-and-Pillar Projects
· ACPS Longwall Gate Module Calculations
· Multiple Seam Option: LAM 2D
· Output

6.1 ACPS Development/Room-and-Pillar Calculations

Active Mining Zone (AMZ) / Pillar System

Pillar Calculations

ACPS Loads

ACPS Retreat Module Calculations

Retreat Loads

Loading Conditions

Abutment Angles

Abutment Load Distribution

R-Factors

Front Abutment Loads

Effect of the Slab Cut on the Front Abutment Load

Side Abutment Loads 

Front Abutment Loads Transferred from Remnant Barriers

Pressure Arch Loads Applied to Barriers

Barrier Pillar Loads

Loads Transferred from the Barrier Pillars to the AMZ

Final AMZ Loadings (System Loadings)

Calculations of ACPS Stability Factors

6.1.1 Active Mining Zone (AMZ) / Pillar System

ACPS calculates the Stability Factor for a pillar system, rather than stability factors for
individual pillars, because experience has shown that the pillars within a system work
together. Thus, if an individual pillar is overloaded, it will normally transfer its excess
load to adjacent pillars. If those pillars are adequately sized, the process ends there. A
pillar squeeze occurs only when the adjacent pillars are also undersized. Then they fail
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in turn, resulting in a "domino" of load transfer and pillar failure. The ACPS SF is
therefore a measure of the overall stability of the pillar system. 

For retreat mining, the pillar system is defined as the Active Mining Zone (AMZ).  The
AMZ includes all of the pillars on the extraction front (or "pillar line"), and extends outby
the pillar line a distance of 5 times the square root of the depth of cover. This breadth of
AMZ was selected because measurements of abutment stress distributions (Mark,
1990) show that 90% of the front abutment load falls within its boundaries.

The width of the pillar system or AMZ is the sum of all entry center-to-center spacings. 
If any leave pillar rows are left in an active retreat panel, the width of the AMZ is
reduced to the width of the extracted area (Figure 3).  The area of the pillar system is
its width multiplied by its breadth.

In ACPS, for ease of computation, the pillar system has the same dimensions for
development mining as for retreat mining.

See also: Abutment Load Distribution.

6.1.2 Pillar Calculations

Pillar Area

The pillar area is necessary to determine the load-bearing capacity and the average
stress.  When angled crosscuts are employed, the pillar's area is a parallelogram, and
the program accurately calculates the pillar's least dimension, length, and area.

The area of an individual pillar is calculated as follows:

CPD is the length of the pillar between crosscuts (ft).  For square pillars, it is the
crosscut spacing (XC) minus the entry width.

EPD is the length of the pillar between entries (ft).  For square pillars, it is the entry
spacing minus the entry width.

PHI is the crosscut angle.

CPD = (XC-(WE/SIN(PHI)))*SIN(PHI) EPD(X) = (ECTR(X)-WE)*(1/SIN (PHI))

PILAREA is the area of an individual pillar (sq. ft).

PILAREA(X) = CPD*EPD(X)

Mark-Bieniawski Pillar Strength Formula

ACPS calculates the unit strength of the pillars using the Mark-Bieniawski pillar
strength formula  that considers the effect of pillar length: 
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SP = S1 [0.64 + (0.54 w/h - 0.18 (w*w/hL))]

Where:

S1 = in situ coal strength, assumed = 6.2 MPa (900 psi), w = pillar width,
h = pillar height, and L = pillar length.

The strength of rectangular pillars can be significantly greater than square pillars, due to
the greater confinement generated within them. The Mark-Bieniawski formula was
derived from analyses of the pillar stress distributions implied by empirical pillar
strength formulas. The formula is equivalent to the original Bieniawski formula when
pillars are square. A complete discussion of the Mark-Bieniawski formula is included in
Mark et al., 1995.

See also: Figure 4

Pillar Strength

First, each pillar's least dimension (WW(X)) and maximum dimension (LL(X)) are
determined for use in the pillar strength formula:

IF CPD > WW(X) THEN WW(X) = W(X)
LL(X)=CPD(X) ELSE
WW(X)=CPD LL(X) = EPD(X)

SP(X) is the strength of an individual pillar (psi) determined by the Mark-Bieniawski
formula:

SP(X) = S1*(.64+((.54*(WW(X)/HH)) - (.18 *((WW(X)^2)/(HH*LL(X)))))) 

Pillar Load-Bearing Capacity

The load-bearing capacity of an individual pillar (PLBC(X), in lbs) is determined by
multiplying the pillar strength (SP(X)) by the pillar area (PILAREA(X)):

PLBC(X) = SP(X) * PILAREA(X) * 144

Load-Bearing Capacity of the AMZ

The load-bearing capacity of the Active Mining Zone (LBC, lbs) is determined by first
calculating the load-bearing capacity of one column of pillars (the sum of all the
PLBC(X)), and then multiplying that sum by the fractional number of rows of pillars
within the AMZ (DEPAMZ/XC).  Then load bearing capacities of all the columns of
pillars are combined to obtain the total LBC of the AMZ.
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6.1.3 ACPS Loads

The loadings applied to the Active Mining Zone include development loads, retreat
abutment loads, and multiple seam loads. The development loads are determined by
the depth of cover and the extraction ratio. Abutment loads occur as a result of retreat
mining and gob formation. They are determined by the depth of cover, the width of the
extraction front, the gob extents, and the abutment angles.  Multiple seam loads are
determined primarily by the type of remnant, the distance between the seams, and the
depth of cover.  All these loads may be adjusted by the pressure arch factor.

ACPS uses simple empirical equations to estimate the development and retreat loads. 
The numerical model LAM2D (Heasley and Akinkugbe, 2004) is used to estimate
multiple seam loads.

Development Load Applied to the AMZ

The tributary area load is simply the area of the AMZ, multiplied by the depth of cover
and the unit weight of the overburden:

LDev = H * Gamma * AMZ

Pressure Arch Factor (Fpa)

The Pressure Arch Factor (Fpa) determines how much of the load is initially transferred
from the production pillars in the AMZ to the barrier pillars.  The default value of the Fpa
is 1.0 when the panel width is less than the depth of cover plus 80 ft.  Otherwise, the
default value is:

Fpa = 1 - (0.28 * Log((H) / Wt))

Figure 23 shows the range of values for Fpa.  The total development load applied to the
AMZ is:

LTot(1) = LDev * Fpa

Note that when leave pillars are employed within the active panel, and the width of the
AMZ is reduced accordingly, Fpa is still calculated using the full panel width and not the
reduced value.

6.1.4 ACPS Retreat Module Calculations

Leave Pillar Calculations 

The ACPS Retreat Module allows the user to leave bleeder pillars next to the barrier
pillars within the active panel and/or in the previously mined panel(s).

Leave Pillars Within the Active Panel 
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Leave blocks that are within the active panel reduce the front abutment load because
they reduce the width of the gob, and they reduce the width of the AMZ.  For example, if
a panel is developed 300 feet wide with 5 rows of pillars on 60-ft centers, and one row
of pillars is left during retreat, then the front gob width will be 240 ft.  The width of the
AMZ is also reduced to 240 ft.  

Leave pillars do not affect the Pressure Arch Factor (Fpa), however.  In the example
above, the Fpa would be calculated using the full 300 ft panel width.  Leave pillars within
the active panel also do not affect the load-bearing capacity of the barrier pillars.

Leave Pillars Within Previously Mined Panels

Rows of leave blocks in the previously extracted panel(s) can increase the effective
load-bearing capacity (LBC) of the barrier pillars.  In essence, any "excess" LBC that is
left over from what is needed to carry the tributary area load (TribLdLvBlk) is added to
the LBC of the barrier pillars.

For leave blocks on either side gob (x = 3 and/or 4):

SPLvBlk(x) = S1 * (0.64 + ((0.54 * (WLvBlk(x) / HHEntryHeight)) - (0.18 * ((WLvBlk(x) ^
2) / (HHEntryHeight * L)))))

PLBCLvBlk(x) = SPLvBlk(x) * 144 * WLvBlk(x) * LTribLdLvBlk(x) = (WLvBlk(x) + we) *
Xc * H * Gamma

PLBCLvBar(x) = ((PLBCLvBlk(x)) - TribLdLvBlk(x)) * (DepAMZ / Xc) 

Where:  PLBCLvBar is the excess LBC that will be added to the LBC of the barrier
pillars.

Barrier pillars

The strength of the barrier pillars is determined using the Mark-Bieniawski pillar strength
formula, assuming that the barrier’s least dimension is WBAR, and that it is a long strip
pillar.  Note that slab cuts have a negligible effect on the barrier pillar strength, and so
slab cuts are ignored in the barrier pillar strength calculation.

SPBAR is the strength of the barrier pillar, and PLBCBAR is its load-bearing capacity.

SPBar(x) = S1 * (0.64 + ((0.54 * (WBAR(x) / HHEntryHeight)))) 
If WBAR(x) < HHEntryHeight Then SPBar(x) = 0
PLBCBar(x) = SPBar(x) * WBAR(x) * DepAMZ * 144

If there is any excess load-bearing capacity from a row of leave pillars in the adjacent
side gob (PLBCLvBar), then the excess is added to PLBCBAR to obtain the total
effective LBC of the barrier pillar.
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Remnant barrier pillars

The remnant barrier pillar is the portion of the barrier pillar that is inby the AMZ.  Its width
(WRem) is equal to that of the barrier pillar, except when it has been reduced by a slab
cut.  The effective length of the remnant, LRem, depends on the geometry of the active
gob.  RemStrn is the remnant barrier’s strength, and PLBCREM is its load-bearing
capacity:

ReMStrn(x) = S1 * (0.64 + (0.54 * (WRem(x) / HHEntryHeight))) 
PLBCREM(x) = ReMStrn(x) * 144 * LRem * WRem(x)

If there is a row of leave pillars adjacent to the remnant pillar in the previous panel gob,
and if those pillars have any excess load-bearing capacity (PLBCLvBar), then that
excess capacity is added to PLBCREM.

6.1.5 Retreat Loads

When a gob area is created by full extraction mining, abutment loads are transferred to
the adjacent pillars or solid coal.  The magnitude and location of these loads depend
upon a number of factors, including the depth of cover, the abutment angle, and the
geometry of the gob areas.  The loads are also distributed between the barrier pillars
and the production pillars.  If the barrier pillars are too small to carry their assigned
loads, some of those loads may be transferred to the production pillars.

6.1.6 Loading Conditions

The loading condition defines the number of gob areas. Four possible loading
conditions can be modeled in ACPS, as illustrated in Figure 9.

1. Development Load: Development load, no gob is present.
2. One Active Retreat Section: Development load plus an abutment load from one

active gob area.
3. Active Retreat Section & One Side Gob: Development load plus an abutment load

from one active gob area, plus a second abutment load from one previously mined
side gob.

4. Active Retreat Section and Two Side Gobs: Development load plus an abutment
load from one active gob area, plus two additional abutment loads from two
previously mined side gobs.

6.1.7 Abutment Angles

The abutment angle determines how much load is carried by gob.  Figure 7 shows the
abutment loading for subcritical and supercritical panel widths. The abutment angle has
been calibrated from measurements of longwall abutment stresses, not from
observations of caving angles or subsidence.  These stress measurements indicated
that an abutment angle of 21° is appropriate for normal caving conditions as shown by
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Mark (1990) and Colwell et al. (1999).  The value of 21° was used to analyze all the case
histories in the ACPS data base.

6.1.8 Abutment Load Distribution

When a gob area is created by full extraction mining, abutment loads are transferred to
the adjacent pillars or solid coal. The abutment stresses are greatest near the gob, and
decay as the distance from the gob increases. 

Peng and Chiang (1984) determined from stress measurements that the extent of the
abutment influence zone (D), defined as the distance from the gob edge to the point of
zero stress increase, is 9.3 times the square root of the depth of cover: 

D=9.3*(H^0.5) 

Mark (1990) compiled another series of stress measurements, and determined that
within the abutment influence zone the abutment stress (Sa) decays as the square root
of the distance from the gob edge (see Figure 5). Since the total abutment load can be
estimated (see abutment angle), the abutment stress distribution can be calculated
explicitly. 

See also: Abutment Angle, R-Factors

6.1.9 R-Factors

The front abutment load is reduced if some of the load is distributed to pillars outby the
AMZ.  The R-Factor is the percentage of the total front abutment that is applied to the
AMZ (see Figure 5).   It is calculated as follows:    

R = 1 - (((D - DepAMZ) / D) ^ 3) 

Where D is the extent of the abutment influence zone, D = 9.3 * (H ^ 0.5).  
R cannot be greater than 1.0 or be less than zero.

The default value for the R-factor for the active gob is 0.9, meaning that 90% of the front
abutment load is applied to the AMZ.  This is because the default value for the breadth
of the AMZ is 5 * (H ^ 0.5).

A second R-factor, called RBar(x), is determined for the side abutment load due to a
previous panel.   RBar(x) depends upon the width of the barrier pillar (WBar(x):

RBar(x) = 1 - (((d - (WBAR(x) + (we / 2))) / d) ^ 3)

RBar(x) determines how the side abutment load is shared between the barrier and the
AMZ.  Its value also cannot exceed 1 or be less than zero.
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6.1.10 Front Abutment Loads

In retreat mining, the creation of a mined-out gob area generates abutment loads. The
abutment loads are applied to the unmined coal or pillars adjacent to the gob. The front
abutment load generated by the active gob that is applied to the AMZ is called
LABUT(2).  LABUT(2)  is determined following three rules:

1. The total volume of the overburden above the mined-out area is the depth of cover
multiplied by the gob area.

2. The portion of this volume whose weight is carried by the gob is determined by the
abutment angle (Figure 7).

3. The weight of any element within the remaining volume is carried by the unmined coal
or pillars that is nearest to it.

The calculation of LABUT(2) assumes that substantial remnant barrier pillars are
present to carry a portion of the front abutment. The load generated by the active gob
that is carried by the remnant barriers is called LFTBAR(X).  If subsequent calculation
shows that remnant barriers are too small to carry LFTBAR(X), then some of
LFTBAR(X) will be transferred back to the AMZ and/or to the outby barrier pillar.

Note: In the following equations, the subscript (2) refers to the front, active gob.

TBETA is the tangent of the abutment angle for the front gob: TBETA=TAN(BETA (2))

HCRIT (ft) is the distance into the gob that the influence of a panel edge would be felt, if
no other panel edges interfered. If HCRIT<GEXT/2, the panel is considered
supercritical. Otherwise, it is subcritical.

HCRIT=H*TBETA=H*TAN(BETA(2))

LS(2) is the weight of the wedge of overburden whose weight is responsible for the
abutment load, conceptualized in two dimensions. Its units are lbs/ft. Its calculation
depends on whether the panel is supercritical or subcritical. Figure 7 illustrates the two
possible shapes of the side abutment.

If HCRIT < GEXT(2)/2 THEN LS(2)=(H^2)*(TBETA)*(GAMMA/2) Then
Else
LS(2)=((H*GEXT(2)/2)-((GEXT(2)2)/(8*TBETA)))*GAMMA 
End

The conceptualized three-dimensional volumes of overburden responsible for the front
abutments are illustrated in Figure 9.

Front Abutment, Case 1: In this case, HCRIT is the minimum gob dimension. This
case is a "supercritical" panel in both width (WT) and gob extent (GEXT). In other words,
the front abutment is fully developed. LABUT(2) is the total front abutment load.
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LABUT(2)={[(WT-(2*HCRIT))*LS(2)] + [(2/3)*H*HCRIT2*GAMMA]} * R

Front Abutment, Case 2: In this case, GEXT/2 is the minimum gob dimension. The
front abutment is truncated by a short mined-out area (only several rows of pillars
extracted).

LABUT(2)={[LS(2)*(WT-GEXT(2)] + [GAMMA*(H-((GEXT/2)*(1/TANBETA)))*(GEXT
(2)/2)2] + [GAMMA*(2/3)*(1/TANBETA)*(GEXT(2)/2)3]} * R

Front Abutment, Case 3: In this case, WT/2 is the minimum gob dimension. Case 3 is
a narrow gob, and the abutment load is truncated in both directions.

LABUT(2)= R * GAMMA * {[(H-((WT/2)*(1/TBETA)))*(WT/2)2] + [(2/3)*(1/TBETA)*
(WT/2)3]}

6.1.11 Effect of the Slab Cut on the Front Abutment Load

A slab cut has the effect of increasing the width of the active panel.  An increased panel
width results in an increased front abutment load applied to the AMZ (LABUT (2)). 

ACPS only considers this effect when there is a side gob present.  When a slab cut is
taken from solid coal, the solid coal is assumed to be strong and stiff enough to absorb
the additional load.  This is why, in the “active panel only” condition (loading condition 2),
ACPS does not have a slab cut option.

The slab cut does have the effect of causing a portion of the front abutment load to be
applied to the outby barrier pillar.  LaBarSlb(x) is this load.

6.1.12 Side Abutment Loads

Side abutment loads derive from the previously mined side gobs. The abutment angle
and the gob extent determine the magnitude of the load. Figure 7 shows two cases:
subcritical and supercritical panels.

The side abutment loads are shared between the barrier and the AMZ. The R-factor
RBar(x) determines how the load is shared.  Note: In the following discussion, the
subscript (X) can either be (3) or (4). A value of 3 always refers to the first side gob,
while (4) refers to the second side gob.

The first step is to determine whether the side gobs are subcritical or supercritical.
LS(X) is the cross-section area of the side abutment loading.

For supercritical gobs:
LS(X)=(H^2)*TAN(BETA(X))*(GAMMA/2)

For subcritical gobs:
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LS(X)=((H*GEXT(X)/2)-((GEXT(X)^2)/(8*TAN(BETA(X)))))*GAMMA

LABUT(X) is the initial side abutment loading applied to the AMZ (lbs). If the barriers are
overloaded, additional side abutment load may be transferred to the AMZ.

LABUT(X) = DEPAMZ * LS(X) * (1-RBAR(X))

6.1.13 Front Abutment Loads Transferred from Remnant Barriers

Once all of the initial loads applied to the AMZ, the barrier pillars, and the inby remnant
barrier pillars have been calculated, then the next step is to determine if some load
transfers are necessary because the barriers are not large enough to carry the loads
that are initially assigned to them.  ACPS first evaluates the inby remnant barrier pillars,
and may transfer excess loads to the outby barrier and/or the AMZ.

The total load initially applied to the remnant barrier pillar is the sum of its portion of the
front abutment load, its side abutment load, and its tributary area load: 

RemLd(x) = (LftBar(x) + (Ls(x) * LRem) + ((H * Gamma * WRem(x)) * LRem))

The load-bearing capacity of the remnant barrier (including any contribution from
bleeder pillars left in the previous gob) has already been calculated (PLBCRem(x)). Now
a Stability Factor for the remnant barrier can be calculated as:

RemSF(x) = PLBCRem(x) / RemLd(x)

Now some of LFTBar(x) that is transferred back to the AMZ (LTransRem(x)) if
RemSF<1.5:

LTransRem(x) = ((0.67 * (1.5 - ReMSF(x))) * LftBar(x))

Finally, if the remnant SF is less than 1.5, then some load is also transferred to the outby
barrier pillar.  This load is called LFBar(x).

LFBarMax = ((WBAR(x) + (we / 2)) * Ls(2) * r) - (LaBarSlb(x))

If ReMSF(x) < 1.5 Then LFBar(x) = (0.67 * (1.5 - ReMSF(x))) * LFBarMax

where LFBarMax is the maximum allowable load transfer.

6.1.14 Pressure Arch Loads Applied to Barriers

The pressure arch loadings, LPABar(x), are the portion of the AMZ loads that are initially
applied to the barriers if the panel is deep and narrow enough that a pressure arch is
formed.  These loadings may later be re-applied to the AMZ if the barriers do not have
sufficient capacity to carry them.
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In order to calculate the pressure arch loadings applied to the barriers, it is necessary to
calculate the total AMZ loadings prior to any load transfer from the barriers.  For
example, for loading condition 3, the total AMZ load is the tributary area load (LDEV),
plus the front abutment (LABUT(2)), plus the side abutment transferred across the
barriers (LABUT(3)), plus any loads transferred from the inby remnant barriers
(LTRANSREM(3)).  The Pressure Arch Factor (Fpa) determines how much of these
AMZ loads are transferred to the barrier:

LPABar(3) = (LDev + LAbut(2) * ((1 - Fpa) / 2)
LPABar(3) = LPABar(3) + ((LAbut(3) + LTransRem(3)) * (1 - Fpa))

6.1.15 Barrier Pillar Loads

The total load applied to a barrier pillar (LTOTBAR) is the sum of the tributary area load
(LDBAR), the front abutment load due to a slab cut (LaBarSlb(x)) or due to yielding of
the inby barrier (LFBAR), the side abutment applied to the barrier
(LSBAR), and the pressure arch load transferred from the AMZ (LPABar):

LDBar(x) = H * Gamma * (WBAR(x) + (we / 2)) * DepAMZ LSBar(x) = Ls(x) * RBar(x) *
DepAMZ

LTotBar(x) = LDBar(x) + LFBar(x) + LSBar(x) + LPABar(x) LTotBar(x) = LTotBar(x) +
LaBarSlb(x)

6.1.16 Loads Transferred from the Barrier Pillars to the AMZ

If the outby, solid barrier pillar cannot carry the entire load assigned to it (LTotBar), then
some load is transferred to the AMZ.  The amount of load that is transferred is called
LTRANSBAR(x). In addition, LTRANSBAR(x) includes the pressure arch loads
(LPABar) that cannot be carried by the barrier and are returned to the AMZ.

The size of LTRANSBAR depends upon the Stability Factor for the barrier pillar
(SFBAR(x)).

SFBar(x) = PLBCBar(x) / LTotBar(x)

The maximum amount of load that can be transferred is the same as if the barrier were
gob (in other words, equal to a full side abutment).  There are three possibilities:

1. If SFBAR is greater than 1.5, then no load transfer occurs.
2. If SFBAR falls between 1.5 and 0.5, then a portion of the side abutment and pressure

arch loads are transferred to the AMZ.

LTransBar(x) = (1.5 - SFBar(x)) * (LSBar(x) + (LPABar(x)))

3. If SFBAR is less than 0.5, then the entire side abutment and pressure arch loads are
transferred to the AMZ.
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If SFBar(x) < 0.5 Then LTransBar(x) = (LSBar(x) + LPABar(x))

6.1.17 Final AMZ Loadings (System Loadings)

The system loadings, LTOT, are the final total loadings applied to the AMZ.  For loading
condition 2, LTOT is the tributary area load plus the front abutment, both reduced by the
pressure arch factor. 
LTot(2) = (LDev + (LAbut(2)) * Fpa

For loading conditions 3 and 4, the total load is the tributary area load, plus the front
abutment, plus the side abutment transferred across the barriers (LABUT(3 OR 4)), plus
any loads transferred from the barriers (LTRANSBAR and LTRANS REM) (see Figure
24). 

LTransBar may include pressure arch loads that were initially applied to the barriers.

LTot(3) = LTot(2) + ((LAbut(3) + LTransRem(3)) * Fpa) + LTransBar(3)
LTot(4) = LTot(3) + ((LAbut(4) + LTransRem(4)) * Fpa) + LTransBar(4)

6.1.18 Calculation of ACPS Stability Factors

The Stability Factor, SF, is simply the total load-bearing capacity of the pillars within the
AMZ (LBC) divided by the total load (LTOT).

ACPSSF(x) = LBC / LTot(x)

ACPS reports SF for two conditions: development and retreat.  To obtain the
development SF, ACPS models the conditions that exist during the development of the
panel (in other words, without any active panel gob or slab cuts, but including the effect
of any previously mined side gobs).  The retreat SF models the conditions as the panel
is extracted, including the active gob and any slab cuts.

6.2 ACPS Longwall Gate Module Calculations

Pillar Calculations

ACPS Longwall Loads

Abutment Angles

Side Abutment Load

Abutment Load Distribution

R-Factors

Headgate and Tailgate Loading Factors
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Loading Conditions

6.2.1 Pillar Calculations

The calculations of the pillar area, the pillar strength (using the Mark-Bieniawski
pillar strength formula) and the pillar load bearing area are identical to those used in
the Development/Room-and-Pillar Module. 
 
Load Bearing Capacity of the Gate Entry System

The load-bearing capacity of the Gate Entry System (LBC, lbs per foot of gate entry) is
determined by calculating the load-bearing capacity of each individual pillar (PLBC(x))
per foot of gateroad.  This is accomplished by dividing PLBC(x) by the appropriate
crosscut spacing XC(x).  Then the individual load bearing capacities are combined to
obtain the total LBC of the gate entry system.

6.2.2 ACPS Longwall Loads

Pressure Arch Factor (Fpa)

The Pressure Arch Factor (Fpa) determines how much of the load could potentially be
transferred from the gate pillars the solid coal on either side, if the pillars deformed
significantly.  The default value of the Fpa is 1.0 when the panel width is less than the
depth of cover plus 80 ft.  Otherwise, the default value is:

Fpa = 1 - (0.28 * Log((H) / Wt))

Development Load Applied to the Gate Pillar System

The tributary area load is simply the width of the gate pillar system (Wt), multiplied by the
depth of cover (H), the unit weight of the overburden (Gamma), and the pressure arch
factor (Fpa):

LDev = H * Gamma * Wt * Fpa

Longwall Abutment Loads

When a longwall panel is mined, abutment loads are transferred to the gate pillars.  The
magnitude and location of these loads depends on the depth of cover, the abutment
angle, and several factors that affect the how the load is divided between the gate pillars
and the adjacent solid panels.
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6.2.3 Abutment Angles

The abutment angle determines how much load is carried by gob.  Figure 7 shows the
abutment loading for subcritical and supercritical panel widths. The abutment angle has
been calibrated from measurements of longwall abutment stresses, not from
observations of caving angles or subsidence.  These stress measurements indicated
that an abutment angle B of 21° is appropriate for normal caving conditions as shown by
Mark (1990) and Colwell et al. (1999).  The value of B=21° was used to analyze all the
case histories in the ACPS longwall data base.

6.2.4 Side Abutment Load

The side abutment load per foot of gate entry can be calculated as:

Ls = H2 (Tan B) (Gamma/2) 

for the supercritical panel case (Figure 7a), and 

Ls = [ ((H)(P))/2)) – (P2/(8 (tan B)))] (Gamma) 

for the subcritical panel case  (Figure 7b)

6.2.5 Abutment Load Distribution

The abutment stresses are greatest near the gob, and decay as the distance from the
gob increases. Peng and Chiang (1984) determined from stress measurements that the
extent of the abutment influence zone (D), defined as the distance from the gob edge to
the point of zero stress increase, is 9.3 times the square root of the depth of cover:

D=9.3*(H^0.5)

Mark (1990) compiled another series of stress measurements, and determined that
within the abutment influence zone the abutment stress (Sa) decays as the square root
of the distance from the gob edge (see Figure 5). Since the total abutment load can be
estimated (see abutment angle), the abutment stress distribution can be calculated
explicitly.

See also: Abutment Angles, R-Factors

6.2.6 R-Factors

The load carried by the gate pillars is reduced if some of the load is distributed to solid
coal that will be the second longwall panel. The R-Factor is the percentage of the total
headgate abutment that is applied to the gate pillars.  It is calculated as follows:

R = 1 - (((D - Wt) / D) ^ 3)
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Where D is the extent of the abutment influence zone, D = 9.3 * (H ^ 0.5). R cannot be
greater than 1.0 or less than 0.  

6.2.7 Headgate and Tailgate Loading Factors

The approach used in ACPS assumes that the headgate abutment load (Lhg) and
tailgate abutment load (Ltg) are fractions of the full side abutment load (Ls).  They can
be represented as:

Lhg = Fhg (Ls) or 
Lft = Ftg (Ls) 

where Fhg and Ftg are front abutment factors. Stress measurements were again used
to determine appropriate values of Fhg and Ftg for ALPS (Mark, 1990):

Fhg = 0.5 
Ftg = 0.7

The actual magnitudes of Fhg and F1 are probably affected by local geology, but typical
values should be sufficient for design purposes. 

6.2.8 Loading Conditions

The loading condition defines the number of gob areas. Four possible longwall loading
conditions can be modeled in the longwall gate module, as illustrated in Figure 25.

Headgate loading (Lhg): The pillar loading adjacent to headgate corner of the longwall
face, which is equal to the development load plus the headgate abutment.  Because the
headgate side panel is being extracted, it is assumed that only the tailgate panel is
available to carry pressure arch loads.
LH = ((Ld) ((1 + Fpa)/2)) + ((Ls) (Fh) (R))

Bleeder loading (Lb):  The loading on a pillar system adjacent to a mined-out panel,
which equals the development load plus the full side abutment.
LB = ((Ld) ((1 + Fpa)/2)) + ((Ls) (R))

Tailgate loading (Ltg):  The loading on a double-use gate entry system when it is
adjacent to the tailgate corner of the longwall face, equal to the development load plus
the first side abutment plus the tailgate abutment.  It is assumed that no pressure arch
can develop under this condition.
Ltg = Ld + ((Ls) (1 + Ftg)

Isolated loading (Li):  The loading on a pillar system located between two mined-out
panels, equal to the development load plus two side abutments.
Ltg = Ld + 2 Ls
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6.3 Multiple Seam Option: LAM 2D

Introduction

Multiple Seam Option Analysis Process

Lam 2D

Lam2D Output

6.3.1 Introduction

ACPS can be used to evaluate the potential for multiple seam interactions, and provide
guidance for pillar sizing, supplemental support, and other aspects of mine design. The
Multiple Seam Option provides two distinct evaluations of potential effects of a
multiple seam interaction. The first is a pillar Stability Factor (SF) calculation that
incorporates the multiple seam loads. 

The second multiple seam evaluation is of the entry stability, focusing on the expected
integrity of roof and rib conditions. The ACPS design equation predicts the critical
thickness of the interburden (INTcrit) required to minimize the likelihood of a multiple
seam interaction. 

6.3.2 Multiple Seam Design Procedure

The suggested step-by-step process for using the ACPS multiple seam module is:

1. Identify critical remnant structures on the maps of mining in seams above and below
the target seam.  Every remnant structure that may be crossed by active mine
workings should be evaluated.

2. For each potential remnant structure crossing, determine these ACPS multiple seam
input parameters using the maps and core logs:
· Depth of cover to the target seam (the seam where the mining is currently active);
· Interburden thickness;
· Seam heights (both seams)
· CMRR for the roof of the target seam.

3. Check that the parameters of the case being considered fall within the limits of the
ACPS multiple seam data base.  If the roof of the active seam is very weak
(CMRR<45) or the stress is very high (>5000 psi) then ACPS should be used with
caution.  The same is true if the case involves overmining and the lower coalbed
thickness to interburden ratio is less than 10.  If the interburden thickness is less than
30 ft in either undermining or overmining, then potential for an ultra-close interaction
should be the primary consideration.

4. Determine whether the remnant structure is a gob-solid boundary or an isolated
remnant pillar.  A longwall chain pillar system should be modeled as a single isolated
remnant pillar.  See Multiple Seam Parameters  for more details.
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5. Enter the ACPS multiple seam parameters in the multiple seam tab of the input form.
 These parameters include:
· Whether the active mining is longwall or room and pillar;
· Whether the case is undermining or overmining;
· The interburden thickness;
· The type of remnant structure;
· The active seam CMRR;
· The previously mined seam thickness;
· The width of gob areas, and;
· The width of the isolated remnant pillar (if present).

6. ACPS will automatically conduct a LAM2D analysis of the remnant structure crossing
to determine the multiple seam stress applied to the critical pillar in the target seam. 
AMSS will also determine the total vertical stress by adding the multiple seam stress
to the single seam stress determined from the ACPS Development or Longwall Gate
modules.

7. Check that the pillar design is adequate for the multiple seam loads.  ACPS will
determine the multiple seam pillar stability factor (SFMS) for the active seam, and
compare it to the recommended value (see Stability Factor for the
Development/Room and Pillar Module).  

8. ACPS will calculate the critical interburden (INTcrit) using the design equation (see
Multiple Seam Evaluation).  

9.  If desired, the pillar design in the target seam can be adjusted before running the
program again.  Changing the pillar size changes the value of the TVS, which can
reduce the INTcrit.  Finally, if the INTcrit falls within the “Yellow” range, it might be
desirable to conduct a more detailed analysis using LaModel 3D.

See also:  ACPS multiple seam Design Equation

6.3.3 Lam2D

A key difficulty in multiple seam analysis is obtaining estimates of the multiple seam
stresses.  Running 3-dimensional models of multiple seam situations is difficult and time
consuming.  Fortunately, a simple 2-dimensional model LAM2D (Heasley and
Akinkugbe, 2004) was available for incorporation into ACPS.  Some simplifications are
necessary in order to create 2-D grids of a case history:

· Gob widths are defined by their least dimension; 
· The remnant structure is defined as either a gob-solid boundary or an isolated

remnant;
· Standard LAM2D defaults for the rock and coal moduli, lamination thickness, gob

stiffness, and yielding properties of the previously mined seam were employed;
· Coal elements in the target seam are modeled as elastic (non-yielding) to better

estimate the loads that the ground was attempting to apply to the critical pillars, and;
· An out of seam extraction ratio is applied to the target seam to account for the

crosscuts.
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Figure 15 shows a portion of a typical LAM2D model grid.  The most important variable
value that is derived from the LAM2D model incorporated into ACPS is the average
multiple seam stress on the critical pillar.  This value is then used to determine the total
vertical stress and the multiple seam pillar stability factors.

6.3.4 Lam2D Output

This command button is only available when the "Results" command button has been
invoked and a solution is available.

When the "Lam2D Output" command button is invoked, a child form is presented and
the user can select to view the three type of output files generated by the Lam2D-AMSS
solution module:

· The solution log file generated by Lam2D-AMSS, i.e. the file that shows the
detailed solution steps in the Lam2D-AMSS program.

· The file generated by Lam2D-AMSS to be used as input to the original Lam2D
program.

· The output file generated by Lam2D-AMSS.

6.4 Output

Screen #1 is a listing of case study input parameters

Screen #2 lists the Stability Factors for 
· Development (No retreat mining)
· Development and retreat (Room-and-Pillar with retreat mining)
· With and without multiple seam loads (multiple seam option)
· Development, headgate, bleeder, tailgate, and isolated (longwall gate)

In the multiple seam option, Screen #2 also lists the multiple seam output (predicted
entry conditions and critical interburden values for development and retreat)

Note that the output display starts from screen #2. The user can click on "previous page"
to view the input data used in the analysis and on "next page" to see the remaining
screens.  The user has the option to print any single screen, all screens and also to copy
the contents of the output buffer to the clipboard for importing to other applications (such
as a word-processing program).

Screen #3 is the design loadings screen.  In the Development/Room and Pillar module,
screen #3 also includes the dimensions and other characteristics of the AMZ.

Screen #4 is the pillar load-bearing capacity screen that includes the following:
· Pillar width,
· Width-to-height ratio
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· The unit pillar strength calculated using the Bieniawski formula, 
· The load-bearing capacities of the individual pillars, and
· The total pillar system load-bearing capacity, which is the sum of the load-bearing

capacities of the individual pillars, for the gateroad (tons per ft of gateroad) or the AMZ
(tons).

In the Development/Room and Pillar module, Screen #5 contains data on the on the
barrier pillars, and Screen #6 shows data on the remnant barrier pillars.

6.4.1 Parametric Graphs

The user can create eight types of parametric graphs:  
· Critical Interburden vs Depth of Cover: Separate curves are plotted for

Development and Tailgate Loading or Retreat for the cases with and without
extra support.  

· Critical Interburden vs Crosscut Spacing: Separate curves are plotted for
Development and Tailgate Loading or Retreat for the cases with and without
extra support.  

· Stability Factor vs Depth of Cover: Separate curves are plotted for
Development and Tailgate Loading or Retreat. 

· Stability Factor vs Crosscut Spacing: Separate curves are plotted for
Development and Tailgate Loading or Retreat.

· Average Vertical Stresses: Two curves are plotted. One for the average total
vertical stress and one for the average single seam stress. 

· Average Vertical Stresses - Detail: Two curves are plotted. One for the
average total vertical stress and one for the average single seam stress. The x-
coordinate of the graph focuses in the area around the critical pillar. 

· Vertical Stresses: Two curves are plotted. One for the total vertical stress and
one for the single seam stress as calculated for each element in the 2D grid. 

· Vertical Stresses - Detail: Two curves are plotted. One for the total vertical
stress and one for the single seam stress as calculated for each element in the
2D grid. The x-coordinate of the graph focuses in the area around the critical
pillar.

In all cases the variation of the x-coordinate ranges between the values set in the
ACPS Options settings:

See also: Graph Options

6.4.2 Graph Options

The user can set the basic graph formatting parameters as detailed below:

Graph Title
The graph title is a text string placed over the graph.
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Graph X-axis Title
The x-axis titles selection includes eight text fields, one for each type of parametric
graph that can be specified.  These eight fields correspond to the x-axis titles of the
following graph types:

· Critical Interburden vs Depth of Cover
· Critical Interburden vs Crosscut Spacing
· Stability Factor vs Depth of Cover
· Stability Factor vs Crosscut Spacing
· Average Vertical Stresses
· Average Vertical Stresses - Detail
· Vertical Stresses
· Average Vertical Stresses - Detail

These text strings are placed below the x-axis of each graph.

Graph Y-axis Title
The Y-axis titles selection includes eight text fields, one for each type of parametric
graph that can be specified.  These eight fields correspond to the y-axis titles of the
following graph types:

· Critical Interburden vs Depth of Cover 
· Critical Interburden vs Crosscut Spacing
· Stability Factor vs Depth of Cover
· Stability Factor vs Crosscut Spacing
· Average Vertical Stresses
· Average Vertical Stresses - Detail
· Vertical Stresses
· Average Vertical Stresses - Detail

These text strings are placed to the left of the y-axis of each graph.

Grid Style
Four grid styles are available: Horizontal lines, vertical lines, horizontal and vertical
lines, no grid lines.

Graph Style
Three graph styles are available: lines, symbols, lines and symbols.

Curve Legend
This option enables or disables the legend box in the graph.

Symbol Size
With this scroll box the user can set the size of the symbols used by the graph object.
The scroll box is enabled only for a graph type of "symbols" or "lines and symbols".

Default Formatting Parameter Options
There are two options for the basic formatting parameters: 
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· To set the formatting parameters (i.e. graph title, x-axis title, etc.) every time the
graph options form is invoked.

· To set the formatting parameters to the ones used in the previous graphing
session. These values are saved in the ACPS.INI file.

See also: The Graph Form

Notes:

· Graphics support is provided by Component One which is an independent
graph control not included in the Microsoft Visual Basic 6.0 package.

6.4.3 The Graph Form

This form is used to display a graph generated by the calling program.  The menu
options available are:

File-Print
This option prints the graph to the default printer.

File-Export to Excel
This option exports the data to an Excel spreadsheet.

File-Exit
This option closes the graph form. On some occasions, the option to either keep the
graph or to clear the graph is available.

Edit-Copy
This option copies the graph box to the clipboard for use in other applications.

Options-Basic Options
This option loads the graph options form which includes basic graph formatting
options.

Options-Point ID
When this feature is enabled, the graph object will display the coordinates of each point
graphed on the graph form.  Just click on any point of any curve on the graph and the
coordinates of this point will be displayed in the appropriate boxes.  This feature is
active when a graph is displayed.

Notes:
· Graphics support is provided by Component One which is an independent

graph control not included in the Microsoft Visual Basic 6.0 package.

See also: Graph Options,  Parametric Graphs
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6.4.4 Display Grid

The user can view the grid that is automatically generated and passed to Lam2D for
the multiple seam calculations. There are two options for the grid: 

· Full Grid: where the user can view the full extend of the grid
· Detail Grid: where the user can only view part of the grid around the critical

element in the critical pillar. 

It should be noted that although the horizontal extend of the grid is viewed to scale (i.e.
entry widths are related to pillar lengths, etc), the vertical scale of the grid is only
indicative of the Depth of Cover and the interburden thickness. 

The location of the critical element is also shown, when the user pans to that area.

The zoom function allows the user to zoom in and out of the grid.

See also: Grid Colors

6.4.5 Results Window

The text is organized in pages. By default, the user views the first output page, which is
usually the second page. The first page is reserved for printing the input data. 

The user may navigate through the text of a single page using the vertical scroll bar and
the arrow keys. No editing is allowed. 

Text can be selected (block select) and copied to the clipboard using Ctrl-C. Use Ctrl-A
to select all text in a page.  

In addition, use the command buttons below for additional output navigation and/or
printing operations:

Previous Page: Display the previous page of output (if any).

Next Page: Display the next page of output (if any).

View Plot: Display a plot of the geometry of the mining plan with options to display
dimensions or pillar properties.

Lam2D Output: display a form that allows the user to view the output generated by the
Lam2D code; the visibility of this command button is controlled by the Enable viewing
of Lam2D output file(s) setting in the ACPS Options.

View Grid: Display the grid that is used by Lam2D for multiple seam calculations; the
plot displays on grid for the upper and one for the lower seam.

Print Page: Print current page to any Windows printer.
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Print All: Print all pages to any Windows printer.

Copy Page: Copy current page to the clipboard.

Copy All: Copy all pages to the clipboard (pages separated by carriage return
characters).



Part
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7 The Utilities Menu

Settings

ACPS Options

Grid Colors

Unit Conversions

File Conversion

Clear History Window
This option clears the history (activity) window.

Close/Restore History Window
This option closes or restores the history (activity) window according to the current
window status.

Copy History Window
This option copies the contents of the history window to the clipboard. You can then
paste them to any text handling program for further processing. 

7.1 Settings

This form is used to define a number of default parameters and settings for the AMSS
program:

Default Units
This setting controls the default units for a new or blank project file by configuring the
Units field in the Project Description form. Upon entering and accepting project input
parameters, the default setting in the Project Description form cannot be changed. This
setting is saved in the ACPS.INI file.

Default File Extension for Input Files
This setting is the default 3-letter extension used in the Open and Save dialog boxes in
the File Menu. This setting is saved in the ACPS.INI file.

Data Path
This setting is the default path used in the Open and Save dialog boxes in the File
Menu.  This setting is saved in the ACPS.INI file.

Show Disclaimer
This parameter controls whether the disclaimer message will be displayed when 
loading the ACPS program. This setting is saved in the ACPS.INI file.

Maximize Main Menu Window
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This parameter controls whether the main menu window will be maximized when
loading the ACPS program. This setting is saved in the ACPS.INI file.

Keep Recent File List
This parameter controls whether the program will keep the four (4) recently accessed
data files (opened or saved) as menu items in the File Menu. This setting is saved in
the ACPS.INI file.

Reminder of Annual Updates
This parameter controls whether the program will display a warning that a year has
elapsed since the last update of the program. The update date is internally stored and it
is not related to the install date. Annual updates ensure that any bugs that have been
discovered are fixed regularly. This setting is saved in the ACPS.INI file.

Display Command History Window
This parameter controls whether the program will display recently executed commands
(and their resulting actions).  This setting is saved in the ACPS.INI file.

Maximum Characters in Command History Window
This parameter sets the maximum number of characters displayed in the command
history window, before it is cleared.  This setting is enabled only if the Display
Command History Window option is enabled.  This setting is saved in the ACPS.INI
file.

History Font
This button sets the type and size of font used in the command history window. This
setting is enabled only if the Display Command History Window option is enabled.
This setting is saved in the ACPS.INI file.

Enable Toolbar
This settings controls whether the program will display a toolbar under the main menu
options or not. The toolbar is not editable. This setting is saved in the ACPS.INI file.

Short Names in File List
This parameter controls whether the program will display the filenames in the recently
accessed list in a short or long format (i.e. including the whole path).  This setting is
saved in the ACPS.INI file.

Load Last Input File
When this setting is enabled, the program will automatically load the most recently
saved datafile (i.e. the top in the recently accessed files). This setting is saved in the
ACPS.INI file.

Copy Example Files
When this setting is enabled, the program will automatically copy all example files from
the "Program Files" directory to the user home directory (i.e.
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MyDocuments/MyNIOSH). This procedure runs upon every program invocation unless
disabled. The modified files will not be overridden, but missing files will be replaced.
This setting is saved in the ACPS.INI file.

External Viewer
This option allows the user to specify the external ASCII viewer/editor that will be used
when displaying ASCII data. The default setting in this option is to use the Notepad
editor. This setting is saved in the ACPS.INI file.

7.1.1 ACPS.INI

Description:

This file is automatically created by the ACPS program the first time it is executed. It
should reside in the default document directory for this program, i.e. in the
MyGroundControl subdirectory of the (My) Documents directory in the computer where
the program is installed (\Documents\MyGroundControl\). Note that in a network
environment the Documents directory may reside on a different hard drive. The INI file
contains entries such as the ones shown below (the sequence and parameter values
may be different in the actual file):

[Settings] 
DefaultUnits=0 
DisplayActionWin=1 
MaxDisplaySize=300 
KeepFileNames=1 
ShowDisclaim=0 
DataPath=C:\ACPS\ FileExtension=ACP

[FileMenu] MaxLastFiles=4
LastFile1=C:\ACPS\S1.ACP 
LastFile2=C:\ACPS\S2.ACP 
LastFile3=C:\ACPS\S3.ACP 
LastFile4=C:\ACPS\S4.ACP

[TextBrowse] BrowseFontName=Courier New BrowseFontSize=10 BrowseFontBold=0
BrowseFontItalic=0

Note: If this file is deleted, it will be automatically reconstructed the next time the
program is executed, but the various settings will default to their original values.

7.2 ACPS Options

This form is used to define a number of default parameters and settings for the AMSS
program:
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Edit/Print Options

View/Plot Options

Output Options

Multiple Seam Options

7.2.1 Edit/Print Options

Load the Input Form on File Open
If this option is enabled, the input project parameters form will be automatically loaded
in the following situations:
· File - New is selected.
· File - Open is selected and a file is loaded.
· An existing file is loaded from the recent file list.

Issue Warning when Discarding Changes in Input Form(s)
If this option is enabled, then a warning message will be displayed when the user
discards changes from the input form(s), by clicking on Cancel or by closing the
window form.

Create a File Association
Use this option to create an association between the program executable and the
extension of the project files.  Thus, double-clicking on a project file will invoke the
ACPS program.

Print Module Version Information
If this option is enabled, then whenever the input data are printed, a three-line header is
prepended with the program version, filename, etc.

7.2.2 View/Plot Options

View Project File in Child Window
If this option is enabled, then the View button in the ACPS parameter entry form will
launch a separate view window with a sketch of the mine plan. The image in this
window can be copied or printed.

Plot Entry Spacing Dimensions
If this option is enabled, then the entry spacing dimensions will be plotted on any output
plot.

Plot Crosscut Spacing Dimensions
If this option is enabled, then the crosscut spacing dimensions will be plotted on any
output plot.

Dimension Crosscut Spacing ONCE
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If this option is enabled, then the crosscut spacing dimension will only be plotted
ONCE.

Dimension Barriers and Pillars 
If this option is enabled, then the dimensions of the barriers and the gobs will also be
plotted. 

Longwall: Plot Belt Entry as Entry #1
If this option is enabled, then the belt entry will be entry #1, otherwise the belt entry will
be the middle entry. 

Plot Gob Width Options
This option controls plotting of the gob width. The gob width may be plotted in the same
scale as the rest of the mine plan, or schematically (i.e., not to scale).  If the "Plot gob
width to scale" option is selected, then the gob width will be plotted in the same scale
as the rest of the mine plan.

7.2.3 Output Options

Output Units (Strength)
If the imperial unit system is selected, the user has two options regarding the strength
(pressure) units used in the output forms:

· psi [pounds (force) per square inch]
· psf [pounds (force) per square foot]

Output Units (Pressure Gradient)
If the imperial unit system is selected, the user has two options regarding the pressure
gradient units used in the output forms:

· lbs/ft [pounds (force) per foot]
· tons/ft [tons (force) per foot]

Range of Parametric Analysis
These numbers control the range (minimum and maximum) of the X-Axis values to be
generated when parametric graphs are requested. Default values are 80% for
minimum and 120% for maximum. For example, if the x-axis of a parametric graph
refers to the overburden depth, and the entered value is set to 500 (ft), then for the
above values the parametric graph will be generated for x-values in the range of 400-
600 as follows:

· xmin = 500 * 80/100 = 400
· xmax = 500 * (120/100) = 600
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7.2.4 Multiple Seam Options

Lam2D Cell Size
Specify the Cell Size to be used when creating the grid for the Lam2D module (in ft and
m).

Enable Viewing of Lam2D Progress Information (Parameter Forms)
If this option is enabled, then the user will be able to follow the progress of invoking and
calculating stresses using Lam2D in a window at the bottom of the ACPS parameter
entry form.

Enable Viewing of Lam2D Progress Information (Output Menu)
If this option is enabled, then the user will be able to follow the progress of invoking and
calculating stresses using Lam2D through the output menu, both in the case of simple
calculations and in the case of generation of parametric graphs.

Enable Viewing of Lam2D Output File(s)
If this option is enabled, then the user will be able to view in an ASCII editor the output
generated by Lam2D. This consists mainly of two files. One file can be used as input to
the standalone Lam2D program and the other is the log file generated by
Lam2D_AMSS to track solution progress.

· If this option is enabled, then the Lam2D button that appears in the ACPS parameter
form will be disabled until the problem is solved (i.e. the results button is clicked).
After that it is enabled.

· If this option is not enabled then the Lam2D button that appears in the ACPS
parameter form will not be visible in any case.

Temporary File Location
The user can select the location of the temporary files. This setting should not be
changed for the average user. There are four available options:
· Application Directory (may not be allowed), i.e., the directory where the application

has been installed.
· User Temporary Directory (Hidden) [default option], i.e. the directory under

"\Documents\User\Local Settings\Temp", where user is the login name of each user. 
This directory is automatically created when a new user is created.

· Root Directory (may not be allowed), i.e., the C:\ directory.
· MyGroundControl Temp Directory (not Hidden) (this directory is automatically created

as "Documents\MyGroundControl\Temp" during program startup if it does not already
exist).

7.3 Grid Colors

This form is used to define the background and foreground colors for inseam material
codes that are used in Lam2D to generate the multiple seam stress regime.  These
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colors are used when viewing the Lam2D grid using the View Grid command button of
the Results window (see below). 

The program sets default colors upon initiation as shown below. The user can change
these colors to custom settings. These custom settings are saved in the ACPS.INI file. 
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7.4 Unit Conversions

This utility can be used to convert between English and metric units for 4 types of units:

Pressure
Conversion between psi (pounds per square inch), Pa (Pascals) and MPa
(MegaPascals) is supported.

Length
Conversion between feet, inches, meters and centimeters is supported.

Stress (Pressure) Gradient
Conversion between psi/ft (psi per foot), psi/in (psi per inch), MPa/m (MegaPascal per
meter) and Pa/m (Pascal per meter) is supported.

Load Gradient
Conversion between lbs/ft (pounds per foot), lbs/in (pounds per inch), kN/m (kiloNewton
per meter) and MN/m (MegaNewton per meter) is supported.

Notes:
· 1 Pa = 1 Newton per square meter
· 1 psi = 1 pound per square inch

7.5 File Conversion

This utility can be used to convert the current file to a different set of units. If the file is
in English units, then it can only be converted to metric and vice versa.

Notes:
· The current file should already be saved before accessing the conversion

option.
· The current file is then substituted with the converted file.
· A prefix is added to the name of the converted file.

(this option is not active yet)
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8 The Help Menu

Use the Help menu option to access various Help options, the Disclaimer screen, as
well as information regarding the current version of the program.

Disclaimer of Liability Clause:
This software is provided 'AS IS' without warranty of any kind including express or
implied warranties of merchantability or fitness for a particular purpose. By acceptance
and use of this software, which is conveyed to the user without consideration by the
developers, the user expressly waives any and all claims for damage and/or suits for
personal injury or property damage resulting from any direct, indirect, incidental, special
or consequential damages, or damages for loss of profits, revenue, data or property
use, incurred by the user or any third party, whether in an action in contract or tort, arising
from access to, or use of, this software in whole or in part. 

See also: About ACPS

8.1 About ACPS

The concept of the "Analysis of Coal Pillar Stability" (ACPS) program was developed
by Dr. Christopher Mark. 

This Windows implementation (version 1.0) was developed by Dr. Zach Agioutantis,
University of Kentucky. The Lam2D DLL file was developed by Dr. Keith Heasley, West
Virginia University.

The help and support of Dr. Christopher Mark during all stages of this project is greatly
appreciated.

8.2 Disclaimer

This software is provided 'AS IS' without warranty of any kind including express or
implied warranties of merchantability or fitness for a particular purpose. By acceptance
and use of this software, which is conveyed to the user without consideration by the
developers, the user expressly waives any and all claims for damage and/or suits for
personal injury or property damage resulting from any direct, indirect, incidental, special
or consequential damages, or damages for loss of profits, revenue, data or property
use, incurred by the user or any third party, whether in an action in contract or tort, arising
from access to, or use of, this software in whole or in part. 

See also: Program Updates
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8.3 Program Updates

No further development or upgrades for this software are planned. However, minor
updates may be issued periodically.  This program is automatically set to remind the
user to check the program web site for an updated version a calendar year after each
revision.  If an update exists, the user may manually download the setup file and install
the new version. 
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8.5 HelpButton

Position the cursor on any item on the form and press F1 for context sensitive
help.
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9 ACPS Figures

ACPS Figure 1:  ACPS Advanced Geometry input parameters
ACPS Figure 2: Other ACPS input parameters for the Development/Room-and-Pillar
module
ACPS Figure 3: Leave Pillars within the active panel.
ACPS Figure 4: The Mark-Bieniawski formula for the strength of rectangular pillars.
ACPS Figure 5: The Active Mining Zone (AMZ)
ACPS Figure 6: ACPS standard loading models.  (a) Tributary area.  (b) Pressure arch.
ACPS Figure 7: The abutment angle concept in ACPS
ACPS Figure 8: Estimation of the depth of cover for ACPS.
ACPS Figure 9: Loading conditions for room-and-pillar retreat mining in ACPS.
ACPS Figure 10: Leave pillars (bleeder pillars) in the previous panels (side gobs).
ACPS Figure 11: Undermining.
ACPS Figure 12: Overmining.
ACPS Figure 13: Remnant structures in multiple seam mining.  (a) gob-solid boundaries
associated with a very large pillar and (b) remnant pillar isolated in the gob.
ACPS Figure 14: Upper and approximate lower limits for determining whether a
remnant structure is an isolated remnant or a gob-solid boundary.
ACPS Figure 15: Portion of a typical Lam2D model grid used to determine the multiple
seam stress and total vertical stress.
ACPS Figure 16: Performance of the design equation, comparing the suggested
Critical Interburdens with the actual interburdens in the case histories.
ACPS Figure 17: ACPS room-and-pillar case history data base, showing the
recommended ARMPS 2010 SF of 1.5 for production pillars.
ACPS Figure 18: The role of barrier pillars in room-and-pillar retreat mining.  (c)
Pressure arch, with side gob and adequate barrier pillar.  (d) Side gob without adequate
barrier pillar (same AMZ load for both pressure arch and tributary area loading models).
ACPS Figure 19: Alternative ACPS design criteria for narrow panels and reinforced
barrier pillars.
ACPS Figure 20: Relationship between entry width and CMRR in the longwall case
history data base.
ACPS Figure 21: Relationship between primary roof support and CMRR in the longwall
case history data base.
ACPS Figure 22: Schematic of the loadings applied to a longwall pillar system.
ACPS Figure 23: The Pressure Arch Factor (Fpa) as a function of depth for three
different panel widths.
ACPS Figure 24: Final AMZ loadings.
ACPS Figure 25: Stages in the service life of longwall pillars. 
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9.1 ACPS Figure 1

Figure 1.  ACPS Advanced Geometry input parameters.
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9.2 ACPS Figure 2

Figure 2.  Other ACPS input parameters for the Development/Room-and-Pillar module
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9.3 ACPS Figure 3

Figure 3.  Leave Pillars within the active panel. 
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9.4 ACPS Figure 4

Figure 4: The Mark-Bieniawski formula for the strength of rectangular pillars.
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9.5 ACPS Figure 5

Figure 5.  The Active Mining Zone (AMZ)

9.6 ACPS Figure 6
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Figure 6: ACPS standard loading models.  (a) Tributary area.  (b) Pressure arch.

9.7 ACPS Figure 7

Figure 7: The abutment angle concept in ACPS.

9.8 ACPS Figure 8

Figure 8.  Estimation of the depth of cover for ACPS.
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9.9 ACPS Figure 9

Figure 9.  Loading conditions for room-and-pillar retreat mining in ACPS.
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9.10 ACPS Figure 10

Figure 10: Leave pillars (bleeder pillars) in the previous panels (side gobs).

9.11 ACPS Figure 11

Figure 11: Undermining.
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9.12 ACPS Figure 12

Figure 12: Overmining.

9.13 ACPS Figure 13

Figure 13: Remnant structures in multiple seam mining.  (a) gob-solid boundaries
associated with a very large pillar and (b) remnant pillar isolated in the gob.
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9.14 ACPS Figure 14

Figure 14: Upper and approximate lower limits for determining whether a remnant
structure is an isolated remnant or a gob-solid boundary.
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9.15 ACPS Figure 15

Figure 15: Portion of a typical Lam2D model grid used to determine the multiple seam
stress and total vertical stress.
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9.16 ACPS Figure 16

Figure 16: Performance of the design equation, comparing the suggested Critical
Interburdens with the actual interburdens in the case histories.
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9.17 ACPS Figure 17

Figure 17: ACPS room-and-pillar case history data base, showing the recommended
ACPS SF of 1.5 for production pillars.

9.18 ACPS Figure 18

Figure 18: The role of barrier pillars in room-and-pillar retreat mining.  (c) Pressure arch,
with side gob and adequate barrier pillar.  (d) Side gob without adequate barrier pillar
(same AMZ load for both pressure arch and tributary area loading models).
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9.19 ACPS Figure 19

Figure 19: Alternative ACPS design criteria for narrow panels and reinforced barrier
pillars.
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9.20 ACPS Figure 20

Figure 20: Relationship between entry width and CMRR in the longwall case history data
base.
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9.21 ACPS Figure 21

Figure 21: Relationship between primary roof support and CMRR in the longwall case
history data base.
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9.22 ACPS Figure 22

Figure 22: Schematic of the loadings applied to a longwall pillar system. 



Analysis of Coal Pillar Stability Manual102

9.23 ACPS Figure 23

Figure 23: The Pressure Arch Factor (Fpa) as a function of depth for three different
panel widths.
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9.24 ACPS Figure 24

Figure 24: Final AMZ loadings.
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9.25 ACPS Figure 25

Figure 25: Stages in the service life of longwall pillars. 
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